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Cautions
• The reproduction of this manual in whole or in part is

prohibited save in cases in which Nikon’s prior permission
has been obtained.

• The information contained in this manual is subject to change
without notice.

• We have made every effort to produce a perfect manual,
but should you find any mistakes, we would be grateful if you
would kindly let us know.  The address of Nikon’s represen-
tative in your area is provided separately.

• Nikon is not liable for damages resulting from the use of this
product.

Trademark Information
Macintosh is a registered trademark of Apple Computer, Inc.

Microsoft and Windows are registered trademarks, and Windows NT a
trademark, of Microsoft Corporation.

IBM PC/AT is a trademark of International Business Machines Corporation.

i386, i486, Pentium, and Pentium II are trademarks of Intel Corporation,
U.S.A.

Adobe is a registered trademark, and Photoshop a trademark, of Adobe
Systems, Inc.

The Defect Correction function incorporated in the LS-2000 makes use of
Digital ICE technology developed by Applied Science Fiction Inc.  Digital ICE
and the Digital ICE logo are trademarks of Applied Science Fiction Inc.

Other brand or product names are the trademarks or registered trade-
marks of their respective holders.
Cautions
Notice concerning prohibition of copying or reproduction
Note that simply being in possession of material which has been
copied or reproduced by means of a scanner may be punish-
able by law.

• Items prohibited by law from being copied or reproduced
Do not copy or reproduce paper money, coins, securities,
government bonds, or local government bonds, even if such
copies or reproductions are stamped “Sample”.

The copying or reproduction of paper money, coins, or securi-
ties which are circulated in a foreign country is prohibited.

Unless the prior permission of the government has been
obtained, the copying or reproduction of unused postage
stamps or post cards issued by the government is prohibited.

The copying or reproduction of stamps issued by the govern-
ment and certified documents stipulated by law is prohibited.

• Cautions on certain copies and reproductions
The government has issued cautions on copies or reproduc-
tions of securities issued by private companies (shares, bills,
checks, gift certificates, etc.), commuter passes, or coupon
tickets, except when a minimum of necessary copies are to
be provided for business use by a company.  Also, do not
copy or reproduce passports issued by the government,
licenses issued by public agencies and private groups, ID
cards, and tickets, such as passes and meal coupons.

• Comply with copyright notices
The copying or reproduction of copyrighted creative works
such as books, music, paintings, woodcut prints, maps, draw-
ings, movies, and photographs is prohibited except when it is
done for personal use at home or for similar restricted and
non-commercial use.
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Overview
Thank you for your purchase of a Nikon scanner.  This refer-
ence manual explains how to use Nikon Scan 2.0 for the
Macintosh.  The Macintosh version of Nikon Scan 2.0 functions
as a acquire plug-in, allowing you to scan images from your
Nikon Film Scanner into any application that supports Adobe
Photoshop version 4.0 plug-ins.  It can also be used as a stand-
alone scanning application for scanning images into your com-
puter and saving them to disk.

Nikon Scan 2.0 supports scanning with the LS-2000 (SUPER
COOLSCAN 2000).  It allows non-sequential and batch scan-
ning using the SA-20 strip-film adapter or IA-20 IX240 film
adapter (sold separately).  It also supports unattended sequen-
tial scanning with the slide-feeder adapter available for the LS-
2000.  Other features include:

• a scan window incorporating a wide variety of advanced
setting options, making it possible to make fine adjustments
to images before they are scanned

• a “defect correction” function that processes images digitally
to remove dust and scratches during scanning

• support of grayscale, RGB (sRGB), HSL, and CMYK color
models, producing images suited to a wide variety of uses
Overview
• advanced settings such as gamma curve adjustment and hue
editing that allow precise adjustment of images prior to
scanning

This reference manual describes how to install and use Nikon
Scan 2.0 for Macintosh.  The next chapter, “Before You Begin,”
lists the system requirements for Nikon Scan and takes you
step-by-step through the installation process.  For a quick guide
to installation, refer to the User’s Guide.  “Before You Begin” is
followed by “Basic Operations,” which gives an overview of the
steps involved in starting Nikon Scan, adjusting scan settings,
scanning images, and saving images to disk.  “The Scan Window”
gives a detailed introduction to Nikon Scan’s acquire plug-in, or
scan, window and explains scan window preferences.  “The
Thumbnail Drawer” describes Nikon Scan’s thumbnail display,
used when previewing multi-frame film.  The process of select-
ing the portion of an image to be scanned and adjusting can
settings prior to scanning is detailed in “Preview,” “The Size
Drawer,” “The Curves and Levels Drawer,” and “The Color Bal-
ance Drawer,” while ”Saving and Loading Settings” describes how
changes to settings can be saved for later use.  The final chapter,
“Image Window Operations,” describes the options available
when Nikon Scan is used as a stand-alone application.  The
settings available for each scanner are described in separate
appendices.
- 4 -



The present manual describes the operation of Nikon Scan 2.0
for Macintosh.  Refer to your hardware manual for details of
scanner operation.  Purchasers of the LS-2000 can refer to the
Fast Track manual or User’s Guide for a brief description of using
Nikon software with their scanner, while a detailed description
of the software available for Windows may be found in the
Windows reference manual.  We hope you find these manuals
helpful.
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Before You Begin
This section gives the system requirements for Nikon Scan 2.0
for Macintosh and guides you through the process of installing
Nikon Scan 2.0 to your computer’s hard disk.

Note:  This manual assumes a basic understanding of common
Macintosh operations. If you are in doubt about the meaning of
terms used here, refer to your Macintosh manuals.
Before You Begin
System Requirements

To run Nikon Scan 2.0 for Macintosh, you will need system
hardware and software which meet the following minimum
requirements:

• a Power Macintosh, or a Macintosh with a 68030 or better
CPU

• System Software 7.1 or later

• at least 16 MBs or more of RAM available to Nikon Scan (24
MBs or more is recommended)
(When launching this software as an acquire plug-in from
another application, you must also take account of the
amount of memory used by the application.)

• 3 MBs of free space on your hard-disk for installation, with
another 20 MBs of free hard disk space available for tempo-
rary storage while Nikon Scan is running (100 MBs or more
is recommended)

• a monitor with a resolution of 640 x 480 pixels or higher,
with a video system supporting 16-bit RGB Color (32k/64k
colors) or more (Nikon Scan also supports 24-bit True
Color, or 16.7 million colors)

• a CD-ROM drive for installation
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Software Installation

The installation disk provided with this product contains the
Nikon Scan software and the drivers which handle the ex-
change of information between your computer and Nikon
scanners.

Before starting the installation program, check to be sure that:

• no other applications are running

• you have enough free space on your hard disk to install and
run the program  (a minimum of 23 MBs of free disk space is
required, of which 3 MBs must be available in the System
folder; more space will be needed should you choose to
install the applications bundled with Nikon Scan)

• your Nikon scanner is connected to the computer and
powered on (it is not absolutely necessary that the scanner
be connected and powered on at installation, but having the
scanner connected allows you to start using the scanner
without first powering off your computer)

After checking the above points, start installation as described
below.
Before You Begin:  Software Installation
Step 1—Insert the Nikon Scan disk in the CD-ROM drive

After turning on your scanner and computer, start your
Macintosh and insert the Nikon Scan disk in the CD-ROM
drive.  When the CD-ROM is inserted in the drive, a folder
containing one or more installer icons will appear on the desk-
top.  Depending on the region in which you purchased your
scanner, the Nikon Scan CD will contain an English installer
(EN) only, English, French (FR), and Spanish (ES) installers, or
English, French, German (DE), and Spanish installers.

Double-click the installer icon for the language of your choice.
The following window will appear on the desktop.
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Step 2—Accept the software license agreement

Clicking Continue… in the window shown above displays the
Software License Agreement dialog box.  To install Nikon Scan,
you must accept this agreement.  If you choose Decline, the
installer will close.

Note: The Software License Agreement (in Step 2) and the
ReadMe information (in Step 3) can be printed or saved as a file.
Click Print… to display the Print Setup dialog box, or Save
As… to display the Save As dialog box.  When installation is
complete, a copy of the Software License Agreement and Read Me
file will be saved in the folder to which you installed Nikon Scan
2.0.
Before You Begin:  Software Installation
Step 3—View the ReadMe file

Clicking Accept in the agreement dialog will cause the
“ReadMe” file to be displayed.  It is recommended that you take
a view moments to print or view the contents of this file, as it
may contain important information that could not be included
in this manual.

When you have finished reviewing the contents of the ReadMe
file, click Continue to proceed to Step 4.
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Step 4—Select a type of installation

Clicking Continue in the Read Me dialog brings up the Nikon
Scan Installer dialog box.  Select the type of installation you
prefer (Easy Install is recommended for most users).

The default option is Easy Install, displayed in the menu
button at the top left corner of the installer dialog.  If you
choose Easy Install, go directly to Step 5.

Custom install

Custom Install allows the user to choose
what files will be installed.  Click the menu
button at the top left corner of the installer
dialog and choose Custom Install.  The
installer dialog will display the following
items.
Before You Begin:  Software Installation
Select the components you wish to install by checking the
boxes to the left of each item.  Clicking the “I” button to the
right of each item displays information on the item in question.
If you intend to use Nikon Scan solely as a plug-in for another
application such as Adobe Photoshop, you can choose to install
only the Nikon Scan plug-in by checking Nikon Scan Plugin
2.0 as shown above.  To use Nikon Scan as a stand-alone
application you will need to install Nikon Scan.  The Profiles
option installs ColorSync profiles for Nikon Scan.

Note:  For information on the Remove option and the location
of files installed by the Nikon Scan 2.0 installer, see Appendix B.
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Step 5 — Select an installation folder for Nikon Scan

The location to which Nikon Scan will be installed when the
Install button is clicked is shown in the lower left portion of
the installer dialog.  By default, Nikon Scan will be installed in
the “Nikon Software” folder in the top folder of the start-up
disk (if a “Nikon Software” folder does not already exist, it will
be created).  Should you wish to install Nikon Scan in a different
location, you can select a different disk using the Switch Disk
button and select a new folder clicking the Select Folder
button.  This will bring up the dialog box shown below.
Before You Begin:  Software Installation
Specify the folder to which you would like to install the soft-
ware and then click Select button.  This will return you to the
Installer dialog.

The other items in this dialog box are explained below.

Read Me…
Returns you to Step 3.
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Go to Nikon Home Page
If you have an Internet connection, clicking Go to Nikon
Home Page will start your Web browser (Netscape
Navigator 3.0 or better or Internet Explorer 3.0 or better
required) and take you to the Nikon technical support home
page for the region in which your scanner was purchased.
Nikon home pages for different regions are given below.

Region URL
Europe http://www.nikon-euro.com
U.S.A. http://www.nikontechusa.com

Quit
Click Quit to close the installer without installing Nikon
Scan.

Step 6 — Install Nikon Scan

Click Install to install Nikon Scan to the selected folder.  While
the program’s components are being installed, the following
progress indicator will be displayed.
Before You Begin:  Software Installation
Interrupting installation

Clicking Stop in the Installing dialog interrupts the installation
and brings up the following dialog box.

Click Stop to quit the installer without installing Nikon Scan, or
Resume to continue installation.   Clicking Stop will display a
message to the effect that installation has been cancelled; click
OK.

Should you choose to quit the installation program, you will still
be able to complete installation at any time by repeating the
process from Step 1.
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Select a plug-ins folder
The Nikon Scan application and Nikon Scan plug-in will be
installed to a folder named “Nikon Scan 2.0” under the “Nikon
Software” folder in the folder and volume (disk) selected in the
installer dialog.  To launch Nikon Scan from another application,
you will need to install a copy of the Nikon Scan plug-in in the
application’s plug-ins folder.  The installer will automatically
locate plug-ins folders and display them in the following dialog.

After selecting the plug-ins folder belonging to the application
from which you would like to be able to launch Nikon Scan,
click OK.  Click Cancel to install the Nikon Scan plug-in to the
Nikon Scan 2.0 folder only (if at a later date you should find
that you would like to be able to scan images directly from
Nikon Scan into another application, you can add Nikon Scan to
the application’s list import plug-ins by copying Nikon Scan
Plugin 2.0 from the Nikon Scan 2.0 plug-ins folder to
application’s plug-ins folder).

Before You Begin:  Software Installation
Step 7—Complete installation

Once the installer has finished copying Nikon Scan to the
installation folder, the following dialog will be displayed.  Click
Quit to exit the installer.  Clicking Continue will return you to
the Installer dialog box shown in Step 4.

Once you have returned to the Finder, locate the Nikon Scan
2.0 folder in the directory you chose in Step 5.
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Step 8—Check the memory available to Nikon Scan

Before using Nikon Scan 2.0 , check the amount of memory
allocated to the program.  Open the Nikon Scan 2.0 folder and
click the Nikon Scan 2.0 icon once to select it.  Then choose
Get Info ( I) from the File menu in the Finder.  The following
information dialog will appear.  If possible, in the “Preferred
size” text box enter a value equal to or greater than the sug-
gested size.
Before You Begin:  Software Installation
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Basic Operations
This chapter provides a brief introduction to Nikon Scan 2.0’s
windows, menus, and buttons, and guides you step-by-step
through the basics of using Nikon Scan 2.0 to acquire images
from your scanner, modify them, and save them to disk.  The
details of each operation are provided in the chapters that
follow.

Note:  In addition to the strip-film and slide adapters provided
with your scanner, a slide feeder and IX240 film adapter are
available separately for the LS-2000.
Basic Operations
Step 1—Connect the scanner

Connect the scanner to your computer as described in your
scanner’s user’s manual, first making sure that both devices are
off.  Turn the scanner and any other peripheral devices on, then
turn on your computer.

Step 2—Start Nikon Scan

Locate the Nikon Scan 2.0 folder in the destination folder you
chose during installation.  Open the folder and double-click the
Nikon Scan 2.0 icon.

When Nikon Scan starts up, the menus shown below will
appear in the menu bar and the scan window (where you will
preview images and make adjustments prior to scanning) will
open on the desktop.

▼ The Nikon Scan menu bar
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The left side of the scan window is a control area containing a
collection of buttons and menus, while on the right is the pre-
view-image display area in which a preview of the image to be
scanned is displayed.  If no adapter is in the scanner or if no film
is inserted in the adapter, all controls other than the prefer-
ences button will be grayed out and inactive.

▼ The Nikon Scan scan window

Control area Preview/crop area

Title bar
Basic Operations
Note:  If the MA-20 Slide Mount Adapter is inserted in the LS-2000

film scanner, all controls will be active regardless of whether there is a

slide in the adapter or not.  If there is no slide in the adapter, clicking

the autofocus, prescan, preview, or scan buttons will produce an error.

Click OK in the error message box, check that a slide is inserted in the

adapter, and repeat the autofocus, prescan, preview, or scan operation.

Launching Nikon Scan from another application

The scan window can also be opened from any application that
supports Adobe Photoshop version 4.0 plug-ins by selecting
Nikon Scan 2.0 as the application’s acquire plug-in.  See the
application manual for details.  When Nikon Scan 2.0 is used as
an acquire plug-in for another application, the Nikon Scan menu
bar will not appear; instead, images will be passed directly to the
calling application when scanned.

Choosing a scanner

Nikon Scan will open a separate scan window for every sup-
ported scanner that is connected and powered on at the time
the application starts up.  The name, host adapter, and SCSI ID
of each scanner is shown in the scan window title bar.  Clicking
the scan window for the desired scanner to activate it and bring
it to the front, or close unneeded windows by clicking the close
button at the left end of the title bar (see “The Scan Window,”
below).
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Step 3—Choose a film type and color space

Having chosen a scanner, select the type of film to be scanned
and the “color space” to be used when scanning the image and
displaying it in the scan window.  Film type and color space may
be selected from pop-up menus in the control area of the scan
window.

Film-type menu button
Color-space menu button
Basic Operations
Film type selection

Clicking the film-type menu button will display the pop-up
menu shown below.  Select the type of film currently in the
scanner.  The chosen film-type will be displayed on the menu
button.  (More details on film-type selection may be found in
“Preview,” below.)

Color space selection

Clicking the color-space menu will display the pop-up menu
shown below.  Click a color space to select it from the list
(the default is “sRGB”).  The chosen color space will be
displayed on the menu button.  (More details on color space
selection may be found in “Preview,” below.)

Note:  If the “Use Nikon Color Management System” check-box
in the Color Management tab of the Preferences dialog box is off,
the color-space menu will differ from those shown above.  The
alternative menu is shown in “Preview,” below.
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Step 4—Select thumbnails

When the strip-film or optional IX240 film adapter is in place,
clicking the thumbnail drawer-tab in the scan window control
area will open the thumbnail drawer.  When the thumbnails
drawer-tab is clicked, Nikon Scan will create thumbnail preview
images for all frames in the scanner and display them in the
thumbnail drawer automatically.

The size of the thumbnail drawer can be changed by dragging
the lower right corner of the drawer.  The drawer cannot be
made larger than the scan window.

Thumbnail drawer-tab
Basic Operations
To select a particular frame for preview, click the associated
thumbnail to select it.  The selected thumbnail will be high-
lighted.  If you then click the preview button, the selected
frame will appear in the preview/crop area of the scan window,
where it can be cropped or scanned as described in the follow-
ing sections.  To close the thumbnail drawer, click the button at
the upper right corner of the drawer.  (More details on thumbnail
display and selection may be found in “The Thumbnail Drawer,”
below.)

Note: Nikon Scan’s thumbnail function can be used when scan-
ning with the LS-2000’s strip-film adapter or the IX240 film
adapter available separately for the LS-2000.  This function is not
available when scanning with other adapters or scanners.
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Step 5—Conduct a preview scan

Before actually scanning an image into your computer, conduct
a preview scan to select an area and orientation for the final
scan and to determine whether adjustments to scan settings are
necessary.  To make a preview scan, click the preview button.

Preview button
Basic Operations
When the preview button is clicked, a preview scan will be
made using the current scan control and color-space settings,
and an image will be displayed in the preview-image display area.
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Step 6—Rotate and flip the preview image

Once a preview image is displayed in the scan window, it can
be rotated or flipped prior to scanning using the flip and
rotate buttons in the control area.

For example, clicking the button below will rotate the preview
image ninety degrees clockwise.  When the scan button is
clicked to make the final scan, the image will be read into Nikon
Scan applet or other calling application in this orientation.

Rotate and flip buttons
Basic Operations
Four buttons are used to control the orientation of the image:

Rotate 90º Clockwise
Click this button to rotate the preview
image clockwise, ninety degrees at a time.

Rotate 90º Counter-clockwise
Clicking this button rotates the preview
image counter-clockwise, ninety degrees at
a time.

Flip Horizontal
Clicking this button flips the preview image
horizontally.

Flip Vertical
Clicking this button flips the preview image
vertically.
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Step 7—Choose an area for the final scan

If desired, an area and location for the final scan can be selected
by using the mouse to specify a rectangular crop area in the
preview-image display.  Only the area within the crop will be
included in the final scan.
Basic Operations
Note:  The coordinates of the current crop appear in the control
area, where the height and width and the coordinates of the top
left corner of the crop are displayed.  For details on how to specify
file size and output resolution for the final scan, see “Preview”
and “The Scan Size Drawer,” below.

The size of the preview-image display can be changed by drag-
ging its lower right corner, while the entire preview/crop area
can be repositioned by dragging the rulers on the top and left
borders of the display.  The preview area can not be made
larger than the scan window as a whole, but the scan window
can be enlarged by dragging its bottom right corner if necessary.
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Zooming the crop area in and out

Clicking the zoom-in button will expand the currently selected
crop to fill the preview area.  The original view can be restored
by clicking the zoom-out button.

Zoom buttons
Basic Operations
Zoom-in
button

Zoom-out
button
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Step 8—Automatic contrast adjustment

If desired, Nikon Scan is capable of modifying contrast adjust-
ment automatically.  Simply click the contrast button.

Note:  When the contrast button is clicked, Nikon Scan analyzes
the preview image to maximize contrast.  The tone curve that will
produce the best possible results is automatically selected. The
original contrast can be restored by clicking the reset button in
the curves-and-levels drawer.  For manual tone-curve adjustment,
refer to “The Curves and Levels Drawer.”

Contrast button
Basic Operations
Step 9—Scan an image

If, after specifying a crop and adjusting contrast, you are satisfied
with the preview image, click the scan button to perform the
final scan.

While scanning is in progress, the following indicator will be
displayed.  Clicking the cancel button stops scanning.

Scan button

Progress indicator

Cancel button
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The scanned image will not appear in the scan window; instead,
the scanned image will be passed to the calling application.  If
you are using Nikon Scan as a stand-alone application, the
image will be opened in an image window on the desk top
where it can be saved to disk, printed, or flipped and rotated
using the commands available in the Nikon Scan menu bar.

▼ The Nikon Scan menu bar

▼ A Nikon Scan image window
Basic Operations
Step 10—Scan additional images

If the scan window is clicked, the scan window will be activated
and another image can be scanned (if you are using Nikon Scan
2.0 from within another application, the scan window can be
activated by selecting Nikon Scan from the application’s acquire
menu).  When additional images are scanned, each will appear
in an image window in the host application or in the Nikon Scan
applet.

Note:  If a slide feeder is being used with the  LS-2000 film
scanner, clicking the Eject and Feed button in the scan window will
eject the current slide and feed the next one.  This button can also
be used to eject film from the LS-2000’s strip-film or IX240
adapters.

Eject and feed
button
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Opening the scan window

If the scan window is no longer open on the desktop, a scan
window can be opened by choosing a scanner from the devices
listed in the Devices submenu of the Nikon Scan menu
(scanners not supported by Nikon Scan will not be displayed).
To re-launch Nikon Scan from another application, select Nikon
Scan from the application’s list of acquire sources.
Basic Operations
Step 11—Save scanned images

Choose Save As from the File menu to save the image in the
active image window (if more than one image window is open
on the desktop, click the image to be saved once to activate the
window).
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If the image has not been saved before, or is being saved under
a new name using the Save As… command, the following
Save As dialog will appear.  Specify a file-name, folder, file-type
and image-quality, then click the Save button.

(More details on file-type and image-quality selection may be
found in “Image window Operations,” below.)
Basic Operations
Step 12—Exit Nikon Scan

Choose Quit from the File menu to close all scan and image
windows and exit Nikon Scan.

If an image in an image window has yet to be saved, the follow-
ing dialog will appear.

Click Save to display the Save As dialog shown above, where
the image can be saved.  Clicking Don’t Save closes Nikon
Scan without saving the image.  Click Cancel to return to the
Nikon Scan applet.
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The Scan Window
The “scan window” is where scans are performed and scan
settings adjusted.  This chapter overviews basic scan window
layout and settings.
The Scan Window:  Opening the Scan Window
Opening the Scan Window

When Nikon Scan is started, one scan window will be opened
for each supported scanner connected and powered on (you
can choose the scan window to be opened at start up using the
Preferences dialog box as described in “The Scan Window:
Preferences,” below).  If you are using Nikon Scan as a “stand-
alone” application and have closed the scan window for a
particular scanner, you can re-open the window by choosing
the scanner from the list of devices shown in the Device
submenu of the Nikon Scan menu.  If Nikon Scan is function-
ing as an acquire plug-in for another application, the scan win-
dow can be opened by selecting Nikon Scan from the applica-
tion’s list of acquire or import sources.
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The Parts of the Scan Window

The scan window is composed of the following sections:

• the title bar

• the control area

• the preview/crop area

• the interactive help display
The Scan Window:  The Parts of the Scan Window
The control area is the area on the left side of the scan window
containing a crop information display and the buttons and tabs
used in changing scan settings.  The image to be scanned is
previewed in the preview/crop area on the right of the window,
where the area to be scanned (called a “crop”) can be selected.
The title bar, at the top of the window, shows the name and
firmware version of the scanner currently selected and gives its
SCSI ID and the ID of the host adapter.  The interactive help
display, at the bottom of the window, displays help messages
when the cursor is moved over controls in the scan window.

Title
bar

Control area Preview/crop area
Interactive help
display
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Active controls

The buttons in the control area are active at different times
during the preview and scanning process depending on the
media and adapter used.  Controls that are inactive are “grayed
out” or not colored.  If the current adapter allows non-sequen-
tial scanning of multiple images, a thumbnail drawer-tab will be
displayed at the top of the control area.  This tab will not be
displayed when a slide adapter is inserted in the scanner.

Control area for
slide adapters

Control area for
multiple-image adapters

                                 

Thumbnail
drawer-tab
The Scan Window:  The Parts of the Scan Window
Moving the cursor over any of the drawer-tabs at the left side
of the control area causes the tab to pop out.  Click the tab to
open the drawer and view the controls it contains.  The drawer
can be closed by clicking the arrow tab at the right edge of the
drawer.

Drawer tab

Drawer
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No film/no adapter

If no adapter is inserted in the scanner or if no media are in the
adapter, the scan window will be grayed out and all controls
other than the preferences button will be inactive.

Note:  Adapters will not be recognized unless fully inserted in the
scanner.
The Scan Window:  The Parts of the Scan Window
The controls and settings in the scan window will remain active
if the slide mount adapter or the slide feeder is removed from
the scanner, but the controls will not function as expected.  For
example, clicking the scan button will produce an error.
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Moving and Resizing the Scan Window

The scan window can be moved and resized using standard
window controls.  Drag the bottom right corner of the window
to adjust it to any size between 600 × 450 pixels and the
dimensions of the computer monitor.  Drag the title bar to
move the window anywhere on the desktop.
The Scan Window:  Moving and Resizing the Scan Window
The window control buttons in the title bar offer the following
functions (the buttons shown are for MacOS versions 8.0 or
later; the “window-shade” button is not available in System 7):

 (Close): Closes the window and returns
you to the calling application.

 (Resize): Enlarges the window to fill the
screen.  Clicking the button a
second time returns the window
to its original size.

 (Window-shade):
Reduces the window to a title
bar.  Click the button a second
time to reopen the window.
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Changing the size of the preview/crop area

The size of the scan-window control area is fixed, but the size
of the preview/crop area can be changed by dragging its
bottom right corner.  The preview/crop area can not be made
larger than the scan window.  The preview/crop area can be
moved anywhere in the scan window by dragging the rulers at
the top and left side of the area.

Resizing the preview/crop area
The Scan Window:  Moving and Resizing the Scan Window
Moving the preview/crop area
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Scan Window Preferences

This section discusses the scan window preferences, or basic
scan settings.  Some of these settings depend on the scanner
selected.

Opening the preferences dialog

Clicking the preferences button in the control area of the scan
window, or selecting Preferences from the Edit menu in the
menu bar, displays the Preferences dialog box shown opposite.

Preferences button
The Scan Window:  Preferences
The Preferences dialog contains the following five tabs:
• gamma tab
• color management tab
• device tab
• scratch tab
• miscellaneous tab
The tab currently displayed is indicated by a dark gray bar
above the name of the tab. Clicking the OK button at the
bottom of the window saves any changes to preferences and
returns you to the previous window.  Clicking cancel returns
you to the previous window without saving changes.
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The Device tab

The Device tab is shown below.

Device status
The Device tab gives the status of the devices available, to-
gether with their name and SCSI ID.

open: the scan window for this device is currently
open
The Scan Window:  Preferences
closed: the device is connected but the scan window
for the device is closed

not available:
a previously-connected scanner is either no
longer connected or is off

Selecting the scan window(s) to be open at startup
Using the Device tab in the Preferences dialog, it is possible to
select what scan windows will be opened at start-up when
multiple supported scanners are connected and powered on.
The scan window for devices marked with a bullet in the se-
lect scanner(s) list-box will be opened automatically when
Nikon Scan starts up.  To have the scan window for a given
device open at start-up, select the device in the select scanner(s)
list-box and click the open at start button.  Clicking the
button a second time to prevent the scan window for the
device from opening automatically.  To remove an unavailable
device from the list of scanners, select the device and click
the remove item button.  Devices that were open in your
last session of Nikon Scan cannot however be removed.

Opening a scan window from the Preferences dialog
The scan window for devices currently marked as closed can be
opened by selecting the device in the select scanner(s) list-
box and clicking open now.  This operation has no effect on
whether the scan window for the device will open at start-up.
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The Gamma tab

The Gamma tab in the Preferences dialog allows the user to set
the output gamma values used in displaying preview images and
in making the final scan.

Note:  If you are using the Nikon Color Management System, you
can specify that the gamma values set in the Gamma tab not be
used.  See “The Color Management tab,” below.
The Scan Window:  Preferences
Preview gamma
Gamma compensation for the scan window can be set by direct
input or using the slider.  Adjust the gamma value so that the
gray patterns above the gamma slider match in density.  When
performing this adjustment, it is best if you set the resolution
of the monitor to a low value such as 640 × 480 dots and sit
as far away from the monitor as possible.  To restore the
factory default gamma value of 1.8, click the reset button.

Main scan gamma
Main scan gamma is used when the image in the scan window is
scanned and passed to the host application (if you are using
Nikon Scan as a “stand-alone” application, preview gamma will
be used when the image is scanned; hence the main scan area
will not appear in the Gamma tab).  The gamma value used in
the final scan can be chosen from the following options:

use preview gamma
The gamma value for the final scan will be the same as that
shown in the preview gamma text box.

use application gamma
The gamma value of the calling application is used.

use custom gamma
A value for main scan gamma can be entered in the text box.
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The Color Management tab

Nikon Scan’s Color Management System (CMS) allows you to
select calibrated RGB (sRGB), CMYK, and HSL color models as
the color space for displaying and modifying images prior to
scanning.  You can adjust Nikon Color Management settings
using the Color Management tab in the Preferences dialog.
The Scan Window:  Preferences
If the “use Nikon Color Management System” check-box
in the top of Color Management tab is on (the default setting),
the Nikon Color Management System will be used.  When
CMS is on, the user can choose from sRGB (calibrated RGB ),
CMYK, and HSL color spaces.  When off, only RGB and grayscale
color spaces are available.  To put changes to Color Manage-
ment settings into effect, click the OK button to close the
Preferences dialog, then exit and restart Nikon Scan.

Output color space
The color space used when the image is scanned and passed to
the host application depends on whether Nikon Color Manage-
ment is used.  When CMS is used and Nikon Scan is being used
as an acquire plug-in, the color space chosen in the scan win-
dow color-space pop-up menu (sRGB, CMYK, or HSL) is used
in the scan window only; when scanned, the image is passed to
the host application as RGB data.  When Nikon Scan is being
used as a “stand-alone” application, the color space does not
change when the image is scanned.  If CMS is not used, the
scanned images will be passed to the host application using the
color space specified in the scan window (RGB or grayscale).
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Color management settings

The settings in the Color Management tab apply only when
Nikon Color Management is on.  The following three types of
settings are available:

• preview settings (monitor profile)
• main scan settings (output profile)
• CMYK settings
The Scan Window:  Preferences
When Nikon Scan is being used as a “stand-alone” application,
the output profile is the same as the monitor profile, and the
main scan settings sheet is not available.

Note:  Incorrect color management settings could result in loss of
image quality.  It is recommended that you use the factory default
settings for most purposes.
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Preview settings (monitor profile)
The Preview sheet in the Color Management tab allows you to
choose a monitor profile.
The Scan Window:  Preferences
The following choices are available:

use factory default monitor profile
Nikon Scan’s monitor profile is used (default setting).

use custom monitor profile
This option allows the user to choose a monitor profile
supplied by the monitor’s manufacturer.  When this radio
button is on, the choose profile button will be active.
Clicking the choose profile button displays a standard
open dialog, allowing you to navigate to the folder containing
the manufacturer’s profile.  The selected path will be dis-
played in the text box below the radio button.

use preview gamma (overrides profile gamma)
If this check-box is on, the preview gamma value specified in
the Gamma tab (see above) will be used in place of the
default or custom monitor profile.
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Main scan settings (output profile)
The Main Scan sheet in the Color Management tab allows you
to select the profile used when scanned images are transferred
(output) to the host application (these settings are not available
when Nikon Scan is used as a “stand-alone” application).
The Scan Window:  Preferences
The following settings are available:

use preview profile
The monitor profile settings specified in the Preview sheet
are used.  This is the default setting.

fixed sRGB profile
A fixed sRGB (calibrated RGB) profile is used.

use main scan gamma (overrides profile gamma)
When this check-box is on, the gamma value specified for
main scan gamma in the Gamma tab (see above) will be
used.
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CMYK settings
The CMYK color model is used for output on standard four-
color printers.  A custom CMYK profile can be chosen in the
CMYK sheet of the Color Management tab.
The Scan Window:  Preferences
The following settings are available:

use default CMYK
Nikon Scan’s default color library is used (default setting).

use custom profile
This option allows the user to choose the color library to be
used.  When this radio button is on, the choose profile
button will be active.  Clicking the choose profile button
displays a standard open dialog, allowing you to navigate to
the folder containing the color library.  The selected path will
be displayed in the text box below the radio button.
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The Scratch Disk tab

The Scratch Disk tab in the Preferences dialog box allows you
to choose the volume (disk) or volumes that Nikon Scan uses
for temporary storage, or “virtual memory.”
The Scan Window:  Preferences
The select scratch disk(s) list-box shows the disks available
for virtual memory and the amount of free disk-space on each
disk, with a bullet next to the disks that are currently selected
for temporary storage.  By default, the disk on which Nikon
Scan is located is used for temporary storage.  To add another
disk to be used as virtual memory, highlight the desired disk in
the list-box and click add.  The selected disk will be marked
with a bullet.  To deselect a bulleted disk, highlight the disk and
click delete.  The bullet will disappear, indicating that the disk
will not be used for temporary storage.  To put changes to
scratch-disk settings into effect, click OK to exit the Preferences
dialog, then close all open programs and restart your computer.
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The Miscellaneous tab

The Miscellaneous tab in the Preferences dialog box determines
the initial values for a number of scan window settings.
The Scan Window:  Preferences
Autoexposure
By default, a prescan is performed to determine exposure
levels before a preview scan is made.  If the perform auto-
exposure before preview scan check-box is off, an auto-
exposure operation will not be performed before the preview
scan.

The perform autoexposure before main scan check-box
controls whether a second autoexposure operation will be
performed before the image is scanned and opened in the
host application.  By default, no autoexposure is performed
before the main scan.  If this check-box is on, an autoexposure
operation will be performed before the final scan.

Regardless of how these options are set, an autoexposure
operation will be performed when the prescan button in the
scan window is clicked.

Autofocus
By default, an autofocus operation will only be performed when
the autofocus button in the scan window is clicked (see “Pre-
view,” below).  If the perform autofocus before main scan
check-box is on, an autofocus operation will be performed
before the final scan. This option is not available when the
selected device does not support autofocus.
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Batch scan
Some scanners, such as the LS-2000, can automatically scan
several frames of strip or IX240 film in succession.  Depend-
ing on the scanner, multiple images can also be scanned
automatically using a slide-feeder.  If such a device is selected,
the scanner can be set to stop scanning after an error has
occurred by turning batch scan stops on error check-box
off (by default, the scanner will not stop scanning even when
an error has occurred).

Close thumbnails after preview
By default, the thumbnail drawer remains open after a preview
scan is performed.  If the close thumbnails after preview
check-box is on, the thumbnail drawer will close automatically
after a preview has been performed.

Close window after scanning
By default, the scan window will remain open after an image has
been scanned and transferred to the host application or to an
image window in Nikon Scan.  If the close window after
main scan check-box is on, the scan window will close auto-
matically when the scan button is clicked to scan an image.

Note:  Some host applications may close the scan window after
scanning regardless of how this check-box is set.
The Scan Window:  Preferences
Acquire thumbnails
By default, the scanner creates and displays thumbnail previews
for all frames when the thumbnail drawer is opened.  If the
always acquire thumbnails check-box is off, thumbnails will
not be created; instead, frames will be indicated by number
only.  Thumbnails can be created and displayed by clicking the
“hide/display thumbnails” button in the thumbnails drawer.

Cache preview images
When a preview image is zoomed in, Nikon Scan stores the
previous preview image so that it can be quickly re-displayed
when the image is zoomed out.  Setting the cache preview
images for slide mount adapter check-box to off forces
Nikon Scan to perform a preview scan every time the image is
zoomed out.

Note:  This function is only available when a slide adapter is
used.

Live picture updates
By default, changes to gamma curves are only reflected in the
preview image after a point on the curve has been dragged to a
new position and the mouse button released (see “The Curves
and Levels Drawer”, below).  If the enable live picture up-
dates check-box is on, the preview image will be updated
continuously while points on the gamma curve are being dragged
to a new position.  This feature makes requires a powerful
computer.
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The Thumbnail Drawer
When a scanner that supports non-sequential scanning of multi-
image media such as strip film or IX240 film is selected, the scan
window’s thumbnail drawer-tab will be activated.  Using the
thumbnail drawer, all images in the film can be previewed as
thumbnail images and one or more selected for full-scale pre-
view or scanning.

Opening the Thumbnail Drawer

Click the thumbnail drawer-tab in the control area of the scan
window to open the thumbnail drawer.

Thumbnail drawer-tab
The Thumbnail Drawer:  Opening the Thumbnail Drawer
The thumbnail drawer can be closed by clicking the box at its
upper right corner.

Note:  Nikon Scan’s thumbnail function is only available when the
scanner currently selected allows non-sequential access to multiple
images.  Non-sequential access is supported on the LS-2000 when
SA-20 strip film adapter or the IA-20 IX240 film adapter are
inserted.  When the strip film adapter is connected, 2–6 thumb-
nails will be displayed depending on the number of frames in the
strip.  Depending on the film used, fifteen, twenty-five, or forty
thumbnails will be shown when the IX240 adapter is in place.  If
the current scanner or adapter does not support non-sequential
access, no thumbnail drawer-tab will be displayed.
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Displaying Thumbnails

The contents of the thumbnail drawer can be displayed either
as thumbnail previews or as frame numbers only.

Thumbnail display

In this mode, small preview images, or “thumbnails,” of all
frames will be displayed in the thumbnail drawer.   By default,
thumbnail previews will automatically be created and displayed
when the thumbnail drawer is opened.

Clicking the “Hide thumbnails” button in the thumbnail drawer
when thumbnails are displayed will replace the thumbnails with
a frame-number display.

Hide thumbnails button
The Thumbnail Drawer:  Displaying Thumbnails
Frame-number display

In this mode, frame numbers are displayed in place of thumbnail
previews. The thumbnails will however be stored in memory,
making it possible to return instantly to a thumbnail display by
clicking the “Display thumbnails”  button a second time.  The
thumbnail images will be kept until the scan window is closed or
film ejected.

Note:  If in the Miscellaneous tab of the Preferences dialog the
“always acquire thumbnails” check-box is on (the default setting),
thumbnails will be created the first time the thumbnail drawer is
opened.  As a result, it may take some time for the drawer to open
the first time the drawer-tab is clicked.  If you prefer, you can
select the frame-number display.  In this case, thumbnail images
are only created when the “Display thumbnails” button is clicked.
Note however that the LS-2000’s SA-20 strip-film adapter adjusts
frame settings when creating thumbnails.  If you conduct a preview
scan without first creating thumbnails, the borders of the frames
may be slightly out of position when the image is previewed or
scanned.

Display thumbnails button
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Resizing the Thumbnail Drawer

When there are too many frames to be displayed at one time
in the thumbnail drawer, a scroll bar will appear at the drawer’s
right border.  Thumbnails can be scrolled a line at a time.
The Thumbnail Drawer:  Resizing the Thumbnail Drawer
The drawer can also be enlarged or reduced in size by dragging
the re-size box at its lower right corner.  The drawer cannot be
made larger than the scan window.  The next time the thumb-
nail drawer is opened, it will be restored to the most recently
specified size.
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Selecting Thumbnails for Scanning

Using the thumbnail drawer, frames can be selected for preview
and scanning.  When a thumbnail or frame number is clicked, it
will be highlighted with a blue border to indicate that it has
been selected.  Selected images can be previewed in the scan
window by clicking the preview button.  A preview operation
will also be performed when a thumbnail or frame number is
double-clicked.  After making any adjustments, click the scan
button to scan the image into the host application or into an
image window in Nikon Scan.
The Thumbnail Drawer:  Selecting Thumbnails for Scanning
Flipping and Rotating Thumbnail Images

Selected frames in the thumbnail drawer can be rotated or
flipped prior to preview using the rotate and flip buttons in the
control area of the scan window.

Rotate and flip buttons

For example, clicking the “Rotate Clockwise” button (  ) with
a frame selected will rotate the thumbnail ninety degrees to the
right.  When the frame is previewed, it will appear in the scan
window rotated ninety degrees clockwise.
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Scanning multiple frames simultaneously

Selecting multiple thumbnails

Multiple frames can be selected for scanning by holding down
the command key while clicking each frame in turn.  If, after
selecting one frame, you select a second while holding down
the shift key, all frames between the two will be selected.
Frames already selected can be deselected by clicking them a
second time.  Flip and rotate operations apply simultaneously to
all selected thumbnails.
The Thumbnail Drawer:  Selecting Thumbnails for Scanning
Scanning multiple thumbnails

Preview or scan operations can be performed on multiple
selected frames.  When the preview button is clicked, a pre-
view scan will be performed one at a time on the selected
frames and the resulting preview images stored temporarily in
memory.  When any of the previewed thumbnails is subse-
quently selected in the thumbnail drawer, the preview for that
image will be displayed in the preview/crop area.  You can
switch among the images in memory by clicking the thumbnails
of the previewed images.  Crops and scan settings can be
specified separately for each preview.  When the scan button
is clicked, a full scan will be performed on all the frames cur-
rently in memory using the scan settings and crops for each
frame.  The scanned images will be opened in separate win-
dows in the host application or in Nikon Scan.

If the scan button is clicked when multiple frames are selected
in the thumbnail drawer, the images will be scanned and trans-
ferred to the host application one at a time.  If Nikon Scan is
functioning as a “stand-alone” application, the scanned images
will be opened in separate image windows.
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IX240 Film Thumbnails

The number of thumbnail frames displayed varies depending on
the adapter used.  In the case of the IA-20 (IX240 film adapter),
depending on the number of frames in the roll fifteen, twenty-five,
or forty thumbnails will be displayed.
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Preview
Before an image is scanned into another application or into an
image window in Nikon Scan, it can be previewed in the scan
window.  This chapter describes the basic operations that can
be performed prior to scanning, such as rotating and flipping the
image, adjusting contrast and focus, and selecting an area for the
final scan.  Other adjustments that can be made using the
drawer tab controls are discussed in the chapters for each
drawer.

Film Type and Color Space Selection

Before previewing an image, it is necessary to specify the type
of film used in the scanner and to select the “color space” into
which the images are to be scanned.

Specifying the film type

The type of film to be scanned is set using the film-type pop-up
menu in the scan window’s control area.

To specify the film type, click the film-type menu button and
from the menu that appears select the type of film to be scanned
(note that the contents of this menu may vary depending on
the scanner selected).  The current film type will be displayed in
the menu button.
Preview:  Film Type and Color Space Selection
In the case of film scanners, the following film types are sup-
ported.

Positive: Choose this option when scanning positive
film, such as slides

Negative: Choose this option when scanning negatives

Film-type menu button

Film-type pop-up menu
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Choosing a Color Space

When scanning images with Nikon Scan, you must choose a
“color space,” i.e., the color model that will be used in convert-
ing the original, analog image into digital form for transfer to
your computer. This chapter explains the color spaces available
in Nikon Scan and how to change the color space setting.

Clicking the color-space menu button in the scan window’s
control area displays the color-space pop-up menu shown
below.  Choose the desired color space from the menu.  The
selected space will be displayed in the menu button.

                          

Color-space menu button

Color-space pop-up menu
when Nikon Color Manage-
ment is “on”
Preview:  Film Type and Color Space Selection
Color space can be selected from among the following color
models.  The default setting is sRGB (calibrated RGB).

sRGB RGB is the model used in displaying images
on a computer monitor.  Colors are repre-
sented using different intensities of the three
primary colors, red, green, and blue.  Nikon
Scan actually uses a calibrated RGB, or sRGB.

CMYK Colors in the CMYK color model are repre-
sented using combinations of the four colors
commonly used in printing (cyan, magenta,
yellow, and black).

HSL Colors in HSL are represented using hue,
saturation, and luminosity.  Nikon Scan uses a
calibrated HSL color model.

The selected color space is used for making adjustments to
color balance and tone range in the preview window.  If Nikon
Scan is being used as a “stand-alone” application, the color
space will be preserved when the image is scanned.  When
Nikon Scan functions as an acquire plug-in for another applica-
tion, however, the scanned image will be converted to RGB
before being transferred to the host application.
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Note:  The contents of the color-space pop-up menu vary de-
pending on whether “use Nikon Color Management System” has
been selected in the Color Management tab of the Preferences
dialog.  When Nikon Color Management is “on” (the default
setting), the menu shown above will appear.

The color-space menu when CMS is off

When the “use Nikon Color Management System” check-box
in the color management tab of the Preferences dialog is “off,”
the following color-space menu will appear.

Color space can be selected from among the following:

RGB Uncalibrated RGB

Grayscale The image will be represented using 256
shades of gray

Note:  If you are scanning black-and-white (monochrome) film,
the best results will usually be obtained with a grayscale color
space.  To select a grayscale or uncalibrated RGB color space, you
must first open the Preferences dialog to the Color Management
tab, set the “use Nikon Color Management System” check-box to
off, click OK to close the Preferences dialog, and then quit and
restart Nikon Scan.  The color-space menu will then be that shown
immediately above.
Preview:  Film Type and Color Space Selection
Setting and Ejecting Film

Set the film as described in your scanner’s hardware manual.  If
the current scanner or adapter supports remote ejection, the
eject button will be active, and film can be ejected by clicking
the button.

If the optional SF-200 slide-feeder is inserted in the LS-2000,
clicking the eject button ejects the current slide and feeds the
next slide from the feed magazine.

Eject and feed
button
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Creating a Preview Image

Clicking the preview button in the scan window’s control area
will cause the scanner to perform a preview scan of the current
slide or currently selected frames and display the resulting image
in the preview/crop area.  While the preview scan is in progress,
the cancel button will turn red to show that it has been acti-
vated.  To stop the preview scan without creating a preview
image, click the cancel button.

Preview button

Cancel button
Preview:  Creating a Preview Image
Changing the size of the preview/crop area

The image in the preview/crop area can be enlarged by first re-
sizing the scan window to make it bigger (see “The Scan Win-
dow,” above) and then dragging the resize handle at the lower
right corner of the preview/crop area to the desired size.  The
preview image will be enlarged to match the size of the preview
area while retaining its proportions.  The image can be reduced
by dragging the corner of the preview area to make it smaller.

Preview/crop area

Resize handlePreview image
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Flipping and Rotating the Preview Image

Prior to scanning, the preview image can be rotated and flipped
using the rotate and flip buttons in the control area of the scan
window.  Any flips and rotations performed on the preview
image will be preserved when the image is scanned and trans-
ferred to the host application.

Rotate and flip buttons

The rotate and flip buttons are described in detail below.

Rotating the preview image

The image can be rotated ninety degrees at a time using either
of the following two button:
Preview:  Flipping and Rotating the Preview Image
Rotate Clockwise Button
Rotates the preview image ninety degrees to
the right
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Rotate Counter-Clockwise Button

Rotates the preview image ninety degrees to
the left
Preview:  Flipping and Rotating the Preview Image
Flipping the preview image

The image can be flipped using the two buttons shown below:

Flip Horizontal Button

Flips the preview image horizontally
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Flip Vertical Button

Flips the preview image vertically
Preview:  Flipping and Rotating the Preview Image
Rotating and flipping thumbnails

When the thumbnail drawer is open, rotates and flips will affect
any images selected in the thumbnail drawer.  If the selected
thumbnail is also displayed in the preview/crop area, flips and
rotates will apply both to the thumbnail and the preview image.
If multiple thumbnails are selected, all selected thumbnails will
be rotated or flipped simultaneously.
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Selecting a Crop

When an image is previewed in the scan window, you can
select the area that will be scanned during the final scan.  The
part of the image that will be scanned is called a “crop.”  This
section discusses how to select a new crop and how to change
the size and position of the current crop (the size of the crop
can also be set through direct input, as discussed in “The Scan
Size Drawer,” below).

Making a new crop

To select a crop, move the mouse pointer over the image in
the preview/crop area, then click at one corner of the desired
area and drag the cursor to the opposite corner.  The area
selected will be marked by a frame.  The current crop can be
cancelled by creating another crop or by double-clicking in the
current crop.  If no other crop is specified, the current crop will
have the same dimensions as the image as a whole, with the
result that when the scan button is clicked to perform the final
scan, the entire image will be scanned and opened in the host
application.
Preview:  Selecting a Crop
Note:  When output lock is selected in the scan-size drawer (see
“The Scan Size Drawer,” below), the crop sometimes can not be
enlarged to the same size as the original image by double-clicking
in the current crop.  In this case, you will need to open the scan-
size drawer and click the input-lock button to release output lock.
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Moving the crop area

The crop frame can be moved to a new location simply by
placing the cursor within the frame and dragging it to a new
position.

Note:  “Dragging” means moving the mouse while holding down
the mouse button.

Changing the size of the crop area

To change the size of the crop area, drag a side or corner of
the crop frame.  Dragging a side will change the size of the area
in only one dimension, while dragging a corner allows you to
change both height and width simultaneously.

Note:  When output lock is selected in the scan-size drawer (see
“The Scan Size Drawer,” below), the width-height aspect ratio of
the current crop can not be changed by dragging the crop borders.
To release output lock, open the scan-size drawer and click the
input-lock button.

Note:  For reasons relating to the compression and display of the
preview image, there may be a slight difference between the crop
area specified on the screen and the area that is actually scanned.
When cropping an image, always allow a sufficient margin to
ensure that no important element of the image will be inadvert-
ently cropped out.
Preview:  Selecting a Crop
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The crop coordinates display

The coordinates of the top left corner of the current crop,
together with its height and width, are displayed in the control
area.  By default, size and location are given in pixels, but a new
unit for the display can be chosen from the scan-size drawer.
The units used in the crop coordinate display are also those
used in the rulers at the top and left sides of the preview/crop
area.

Note:  The units used for the rulers and crop coordinates are the
same as the input units specified in the scan-size drawer  (see
“The Scan Size Drawer,” below)
Preview:  Selecting a Crop
Crop
coordinates

Rulers
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Zooming in on the crop area

The user can view the current crop at a higher zoom ratio using
the “Zoom-in” button in the control area.  The “Zoom-out”
button is used to return to a lower zoom ratio.

Zoom in

“Zoom-in” button

If the current crop is smaller than the preview image as a whole,
the “Zoom-in” button in the control area will be activated.
Clicking this button enlarges the crop to fill the preview area.  If
desired, another crop can then be selected within the original
crop and the zoom-in operation performed again to view the
image at a still higher zoom ratio.  To speed processing, Nikon
Scan does not perform a new preview scan each time the
image is zoomed in; the existing preview is used instead.  To
preview the image at the new zoom ratio, click the preview
button.

Zoom out

“Zoom-out” button

After a zoom-in operation has been performed, the original
zoom ratio can be restored by clicking the “Zoom-out” button.
Multiple zoom-in operations can be reversed one at a time by
clicking the “Zoom-out” button several times in succession.
The “Zoom-out” button is only active when the image has
been zoomed in.
Preview:  Selecting a Crop
  “Zoom-in” button“Zoom-out” button  
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Automatic Contrast Adjustment

Contrast can be adjusted automatically to suit the image in the
preview/crop area, creating a more clearly-defined image (con-
trast can also be adjusted manually, as described in “The Curves
and Levels Drawer,” below).  When a preview image is displayed
in the scan window, the auto contrast button (labeled cont)
will be activated.  Click this button to maximize contrast while
retaining the color balance of the original image.

Auto contrast button
Preview:  Automatic Contrast Adjustment
Note:  Auto contrast is only available when the color space is
RGB, sRGB, CMYK, or grayscale.  The auto contrast button has the
same effect as the auto button in the curves-and-levels drawer
(see “The Curves and Levels Drawer,” below).  While auto
contrast is in effect, the tone curves for each color channel will be
automatically adjusted to increase contrast.  The original contrast
can be restored by clicking the reset button in the curves-and-
levels drawer while holding down the option key on the keyboard.
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The Pixel Data Display

When the cursor is moved over the image in the preview area,
color data for the pixel under the cursor are shown in the pixel
data display.

Pixel data display
Preview:  The Pixel Data Display
How the pixel data are displayed depends on the currently
selected color space.  Numerical data will be displayed sepa-
rately for each color element (e.g., red, green, and blue for an
RGB color space, hue, saturation, and luminosity for an HSL
color space).  The displays for the sRGB (or RGB)  and CMYK
color spaces are shown below.  If output levels have been
edited in the curves-and-levels or color-balance drawers (see
“The Curves and Levels Drawer” and “The Color Balance Drawer,”
below), two sets of data will be displayed.  The top line gives
the pixel data for the original image, the bottom the data for
the image as it would appear after scanning.

Pixel data display for sRGB or RGB color space

Pixel data display for CMYK color space
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Autofocus

The autofocus function adjusts scanner focus to compensate for
films of varying thicknesses and for uneven film surfaces.  The
focus position for the autofocus operation can be changed using
the “autofocus” button in the control area of the scan window.

Autofocus button
Preview:  Autofocus
Nikon Scan allows the user to choose from the following two
methods for determining focus:  standard autofocus and auto-
focus based on a user-selected point.  The default is standard
autofocus, in which focus is determined using a point in the
center of the preview image.  To use standard autofocus, click
the autofocus button.

Note:  Using the Miscellaneous tab in the Preferences dialog, it is
possible to set the scanner to perform an autofocus operation
automatically before making the final scan ( see “The Scan Win-
dow: Preferences,” above).

User-selected focus

To change the focus position, hold down the option key on the
keyboard and click the autofocus button.  The cursor will take
the shape of a cross.  Move the cross-shaped cursor over the
point in the preview image that you want to use as the new
focus point and click.  An autofocus operation will be per-
formed using the selected point as the focus position, and the
result of this operation will be used in subsequent scans.

Note:  When a scanner that does not support autofocus is
selected, the autofocus button will be grayed out and inactive.  If
the scanner does not support user-selected autofocus, only stan-
dard autofocus can be used.
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Pre-scan

By default, when the preview button is clicked to scan preview
images, a pre-scan (preliminary scan) operation will be auto-
matically performed to adjust exposure settings.

Note:  A pre-scan will not be carried out before preview if the
“perform auto exposure before preview scan” option in the Miscel-
laneous tab of the Preferences dialog is not checked.  A pre-scan
will not be carried out before the final scan if the “perform auto
exposure before main scan” option is not checked (see “The Scan
Window: Preferences,” above).
Preview:  Pre-scan
To adjust exposure manually, click the prescan button in the
control area.   A pre-scan operation will be carried out regard-
less of the settings in the Preferences dialog.  To stop the pre-
scan operation, click the cancel button.

Prescan button

Cancel button
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Scanning the Image into an Application

After selecting a film and color type, previewing the image,
selecting a crop, and making other adjustments to scan settings
as described above and in the following chapters, the image in
the preview window is ready to be scanned.  To scan the image
into Nikon Scan’s main window or into the calling application,
click the scan button.  While the scanning operation is being
carried out, the cancel button will be activated and a progress
indicator will appear in the control area.  Scanning can halted by
clicking the cancel button.

Scan button
Preview:  Scanning the Image into an Application
If Nikon Scan is being used as a stand-alone application, the
scanned image will be opened in an image window when
scanning is complete (see “Image Window Operations,” below).
If Nikon Scan is being used as an acquire plug-in for another
application, the image will be transferred to the host application.

Progress indicator

Cancel button
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The Scan Size Drawer
This chapter describes the functions of the scan-size drawer in
the scan window.  The scan-size drawer is used to specify the
size and resolution at which images will be scanned into the
host application.  The size controls can also be used to scale the
crop so that it will fit in a specified area or file size, or to create
a crop of specified dimensions.

Opening the Scan Size Drawer

Clicking the scan-size drawer tab in the control window as
shown below opens the scan-size drawer.  The drawer can be
closed by clicking the button at its right edge.
The Scan Size Drawer:  Opening the Scan Size Drawer
     

Scan-size
drawer tab

Scan-size
drawer

Drawer close
button
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Scan-Size Drawer Controls

The scan-size drawer is shown below.

The scan-size drawer is divided into two portions.  The upper
portion contains the input-size display, which gives the dimen-
sions of the current crop.  The input-size display contains the
following items:

• an input lock button, which locks the crop at its current
height-aspect ratio

• an input-units pop-up menu, from which the units used
for the rulers and crop information can be chosen

• a display showing the size of the current crop expressed
using the units chosen in the input-units pop-up menu

• scale slider and text box, which gives the amount the
input crop will be scaled when scanned
The Scan Size Drawer:  Scan-Size Drawer Controls
The lower portion contains output size controls, which deter-
mine the final size of the image after it is scanned.  Output size
controls include the following:

• a file size display giving the size of the file that would
result were the current crop to be scanned at the stated
output settings

• an output lock button, which locks output dimensions and
file size at their current values

• an output-units pop-up menu, from which the units used
for stating output dimensions can be chosen

• output resolution and pop-up menu for output resolution
units

• a device pop-up menu, from which the user can choose
an output resolution suited to a particular output device

Using these controls, the user can select an output resolution
and specify the dimensions and file size of the image to be
scanned.
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Input size

The input portion of the scan-size drawer gives the height (H)
and width (W) of the current crop, which are the actual physi-
cal dimensions of the portion of the medium to be scanned.
New values for crop size can not be entered in the input size
text-boxes, but the size of the crop can be changed by dragging
the borders of the crop in the preview/crop area.

Output size

The output size determines the size of the image after it is
scanned into the calling application.  The output size can be
changed either by adjusting the size of the crop in the preview
image, or by entering values directly into the boxes in the
output size area.  Unacceptable values will be displayed in red.
The size of the current crop is linked to the output size, and
changes when new values are entered in the output height and
width boxes.
The Scan Size Drawer:  Scan-Size Drawer Controls
The units for the input or output size display can be selected
from the pop-up menus to the right of the input- and output-
size text boxes.

Note:  The units used for the input height and width display are
also those used in the scan window crop coordinate display and
preview area rulers.

Input size

Output size
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File size

The file size display shows the size (in bytes, kilobytes, or mega-
bytes) of the image that would be created were the current
crop to be scanned at the current output size and resolution.

It is a good idea to check the file size value before starting a
scan.

Scale

“Scale” expresses the relationship between the input size and
the output size.  If the scale is two-hundred percent, a crop fifty
pixels by fifty pixels in size would be passed to the host applica-
tion as an image of 100 by 100 pixels after scanning.

Scale can be set by dragging the scale slider or entering a value
directly in the input box.  Unacceptable values will be displayed
in red.  The input size remains constant when the scale is changed,
while the output size changes to match the new setting.

Scale

File size

Output
resolution
The Scan Size Drawer:  Scan-Size Drawer Controls
Output resolution

The output resolution is the resolution of the image that will
result when the current crop is scanned.  The resolution chosen
should reflect how the image is to be used; if the image is
ultimately intended for display on a printer with a resolution of
720 dpi, for example, setting the output resolution to 1,350 dpi
would create an unnecessarily large file.  Enter the desired
resolution in the resolution field.  Unacceptable values will be
shown in red.

The units for resolution can be selected from the pop-up menu
to the right of the resolution field.
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Resolution can be set to a value that matches the standard
resolution of a specific output device, such as the computer’s
monitor or the currently selected printer.  To set resolution to
a value that corresponds to the resolution of an output device,
choose the desired device from the pop-up menu at the bot-
tom of the scan-size drawer.  The devices that will be displayed
in this menu depend on what devices are registered on your
system.
The Scan Size Drawer:  Scan-Size Drawer Controls
Input and Output Lock

The scan size drawer contains two lock buttons:  an input lock
button and an output lock button.  One or the other of the
lock buttons is always in effect.

Output lock
button

Input lock
button
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Input lock
The input button locks the height and width of the current
input crop so that when one of these dimensions is changed by
entering a new value in the output size area, the other changes
to maintain a constant height-width aspect ratio.  When clicked,
the button is highlighted in blue.  When a new value is entered
for either height or width in the output size area, the other
dimension will change automatically to maintain the crop at its
current proportions.  This lock affects only the scan size drawer;
the size and position of the current crop can be freely altered in
the preview/crop area using the mouse, in which case the
height-width aspect ratio in the scan size drawer will be locked
at the proportions of the new crop.  To unlock the aspect ratio,
click the output button.
The Scan Size Drawer:  Input and Output Lock
Output lock
The output button locks the output dimensions and file size at
their current values.  When clicked, the button is highlighted in
blue.  Even when the sides of the current crop in the preview/
crop area are dragged to re-size the crop, the output dimen-
sions will not change.  Instead, the scale will change to maintain
the output dimensions and file size at their current values.
When the crop is enlarged, the scale will decrease to keep the
output dimensions the same; similarly, shrinking the crop will
cause the scale to increase.  The crop cannot be enlarged or
reduced beyond the acceptable limits for scale.  When output
lock is in effect, the output dimensions in the output size area of
the scan size drawer can still be changed by direct input, in
which case the scale will not change.  To unlock the output
dimensions and file size, click the input button.
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The Curves and Levels Drawer
Nikon Scan provides two means of color control:  direct ma-
nipulation of the gamma curves via the curves and levels drawer,
and basic color balance adjustment by means of the sliders in
the color balance drawer.  This chapter describes the tools
available in the curves and levels drawer in the scan window.
Color balance is described in the following chapter.

The curves and levels drawer is used to modify the contrast and
brightness for the various color elements (“channels”) in the
output by adjusting the gamma curves and levels either for the
image as a whole or for each color element separately.  In many
cases, the factory default gamma curves, which are designed to
handle the widest possible variety of film, will produce images
with excellent color.  In some cases, however, you may wish to
adjust the gamma curves prior to scanning.  The color balance
drawer provides a simple method of making this adjustment,
but the curves and levels drawer offers more selective control.

Curves and Levels Explained

The curves and levels drawer contains two tools for altering the
gamma curves and levels:  gamma curve adjustment and black
point/white point adjustment.  Gamma curves are plotted on
two axes, one representing the input, i.e., the colors present in
the actual image, and the other the output, which expresses
how the colors in the input will be represented in the final scan.
At one end of each axis is the minimum possible value for the
The Curves and Levels Drawer:  Curves and Levels Explained
color (zero, or no color) and at the other is the maximum value
(the maximum value depends on the scanner’s bit depth; if the
image is to be scanned at a bit depth of eight bits per pixel, the
maximum value will be 255).  The gamma curve determines
how the input values will be converted, or “mapped,” to output
values.  The default mapping is one-to-one, so that input values
of zero are output as zero, while input values of 255 are repre-
sented as 255 in the output.

By altering the gamma curves, it is possible to change the map-
ping between input and output colors at any point on the
curve.  Thus input values of zero could be mapped to a value of
255 in the output, and input values of 255 to a value of zero.  If
the curve between these two points were a straight line, the
result would be a negative image.  In practice, smaller adjust-
ments are made to enhance the tonal range for specific por-
tions of the image, such as shadows, mid-tones, and highlights.
Steepening the slope in a small portion of the curve will accen-
tuate detail in that part of the tonal range, allowing color bal-
ance and definition to be selectively adjusted.
- 71 -



Black- and white- point adjustment allow the user to adjust the
range for each color element, in effect adjusting contrast.  The
black point for a given color represents the darkest shade, or
minimum value for that color in the image.  By default, this value
is zero.  The minimum value in the actual input may however
be greater than zero, with the result that the portion of the
scanner’s tonal range between zero and the actual minimum is
wasted.  Using black point adjustment, it is possible to map the
actual minimum input value to an output value of zero, thus
matching the range of colors in the output to the range avail-
able in the input.  Similarly, white point adjustment can be used
to map the maximum value actually present in the input to the
maximum possible output value, eliminating all values greater
than the maximum input value and making the best use of the
scanner’s tonal range.

White point

Black point

Maximum output
value (255)

O
ut

pu
t

Input0 255

Sh
ad

ow
s

M
id

-t
on

es

H
ig

hl
ig

ht
s

The Curves and Levels Drawer:  Curves and Levels Explained
Default master gamma curve

Increased black-point

(Note increased contrast in highlights and mid-tones and loss of
detail in shadows)

Increased gamma value

(Note overall increase in brightness and loss of contrast in
highlights and midtones)
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The curves-and-levels drawer offers the following four methods
for adjusting gamma curves and levels:
• automatic white point and black point selection
• pixel sampling to determine the white point and black point
• simple gamma curve adjustment using a slider
• fine gamma curve adjustment by adding and moving points

on the curve
The Curves and Levels Drawer:  Curves and Levels Explained
Opening the Curves and Levels Drawer

The curves and levels drawer is opened by clicking the curves
and levels drawer tab.  The drawer can be closed by clicking the
close button.

     

The appearance of the curves and levels drawer depends on
the currently selected color space.

Curves and levels
drawer tab

Curves and levels
drawer

Drawer close
button
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The Curves and Levels Display

The curves and levels display for an RGB color-space is shown
below.  The displays for grayscale and CMYK color-spaces are
similar; the display for a color space of HSL is unique and is
discussed in the final section of this chapter.

The gamma curve window in the curves and levels tab shows
the gamma curve for the currently selected color element, or
“channel.”  The illustration above shows the default gamma
curve, which runs diagonally from the lower left corner of the
window to the upper right.  The input value is plotted on the
horizontal axis, the output value on the vertical.  Thus the left
edge of the gamma curve window corresponds to an input
value of zero, the right edge to the maximum possible input
value for the current channel, while the bottom and top of the
window show respectively the minimum and maximum output
values.

Gamma curve
window

Channel menu
button
The Curves and Levels Drawer:  The Curves and Levels Display
A histogram of the current channel is displayed as a bar graph in
the background of the gamma curve window.  The histogram’s
horizontal axis represents the pixel intensity, the high density
(darker) values appearing on the left and the transparent (lighter)
density values on the right.  The vertical axis represents a scaled
version of the number of occurrences of each pixel value.  The
histogram therefore gives a graphical view of the brightness of
an image.

Channel selection

The gamma curve and histogram for each channel can be
displayed using the channel pop-up menu.  Select the desired
channel from channel pop-up menu for the current color
space, which can be displayed by clicking the channel menu
button.  The current channel is shown in the menu button.
The items available in the channel menu vary depending on the
color space.  Each color space has a master channel, which allows
adjustments that affect all the color elements in the image, and a
separate channel for each of the color elements in the space.  The
menus for the sRGB (or RGB) and CMYK color-spaces are
shown below.

                     

RGB channel pop-up menu    CMYK channel pop-up menu
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The grayscale color space is composed of a single color element
and hence has only one gamma curve.  When the selected
color space is “grayscale,” the channel menu button will not be
shown in the curves and levels drawer.
The Curves and Levels Drawer:  The Curves and Levels Display
The input/output value display

When the cursor is moved over the gamma curve window, the
horizontal (input) and vertical (output) coordinates of the point
under the cursor are shown in the input/output value display.
The range of values shown is 0–255, independent of scanner bit
depth (the actual scanner bit depth is however used in internal
calculations involving the gamma curves).

When the cursor is over the image in the preview/crop area, a
point on the gamma curve corresponding to the value of the
pixel under the cursor will be highlighted.  The input value will
show the actual value of the pixel, the output value the value of
the pixel after the mapping function represented by the gamma
curve has been applied.

Input/output
value display
- 75 -



Gamma Curve Adjustment

The gamma curve for each channel can be adjusted either using
the gamma slider, which raises or lowers output levels for the
curve as a whole, or by adding additional points to the curve to
make more precise adjustments to output levels.

Using the gamma slider

Output levels can be raised or lowered for the entire gamma
curve using the gamma slider at the bottom of the gamma
curve window.  The slider can be activated by clicking it once.

Moving the slider to the left increases all the output values for
the selected channel, while the output values will decrease
when the slider is moved to the right.  The gamma curve will be
altered to reflect the new values, and the preview image in the
scan window will change to show the effects of the new values.

Gamma slider

Reset button

Gamma value
input box
The Curves and Levels Drawer:  Gamma Curve Adjustment
The gamma value input box

The gamma value displayed in the gamma input box to the right
of the gamma curve window is linked to the gamma slider,
increasing as the slider is moved to the left and decreasing as it
is moved to the right.  If desired, the gamma curve can be set
by entering a value between 0.45 and 3.00 in the input box.

Undoing changes

Clicking the reset button will return the gamma curve for the
current channel to linear (equivalent to a gamma value of 1.00).
Clicking reset with the option key held down resets the gamma
curves for all channels to linear.
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Graphically altering the gamma curves

For finer adjustments to output levels, points can be added to
the gamma curve by clicking anywhere in the gamma curve
window.  These points can be freely adjusted by dragging them
to the desired position, changing the shape of the gamma curve.

Adding new points to the gamma curve

Move the cursor into the gamma curve window and click once
anywhere within the window to enter gamma curve edit mode.
Move the cursor to the place you would like to add a new
point, then click.  A new point will appear at this position and
the curve automatically adjusted to pass through this point.  To
move the new point, place the cursor over the point.  The new
points can be moved by dragging them in the gamma curve
window to change the shape of curve.  The preview image in
the scan window will be altered automatically to reflect changes
to the gamma curve.

Reset button
The Curves and Levels Drawer:  Gamma Curve Adjustment
Removing points from the gamma curve

Points can be removed from the gamma curve by dragging
them out of the gamma curve window.

Undoing changes

Clicking the reset button will restore the gamma curve for the
current channel to linear, removing all points but those on
either end of the curve.  Clicking reset with the option key
held down resets the gamma curves for all channels to linear.
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Adjusting the Black and White Points

The left of the gamma curve for a given channel represents the
“black point” for that channel, the right end the “white point.”
Moving the black point to the right results in all input values less
than the black point being mapped to an output value of zero.
Moving the white point to the left results in all input values
greater than the white point being mapped to the maximum
output value.  These tools can be used to adjust the gamma
curve to remove values not available in the input, making better
use of the scanner’s dynamic range and increasing contrast.

Nikon Scan offers three methods for adjusting the white and
black points.  The white and black points can be set automati-
cally, or adjusted manually using the sliders in the gamma
curve window.  The preview image can also be sampled
directly to select a white or black point from the values
actually visible in the original film.

Automatic contrast adjustment

If desired, Nikon Scan can analyze the preview image and select
optimum black and white points for the current channel.  To
perform automatic contrast adjustment, click the auto button
in the curves and levels drawer.  The end points of the selected
curve will be adjusted to optimize the dynamic range for the
entire crop.
The Curves and Levels Drawer:  Black and White Points
To cancel automatic contrast and return the gamma curve to
linear, click the reset button.  If the option key on the key-
board is held down when the reset button is clicked, the
gamma curves for all channels will be reset to linear.

Note:  The effect of the auto button in the curves-and-levels
drawer differs from that of the contrast button in the control area.
The contrast button in the control area affects not just the cur-
rently selected channel but also the master channel, adjusting
contrast for all color channels simultaneously.  Note that this may
sometimes lead to undesirable color balance.  If for example, the
original image is of a predominantly “warm toned” scene, such as
a sunset, then the neutral highlight produced by automatic contrast
adjustment would be too “cold” for the image.

Auto contrast
button

Reset button
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Using the black-point and white-point sliders

The black- and white-points can also set directly for each chan-
nel using the sliders at the bottom of the gamma curve window.
While the sliders can be used to edit the curves for any channel,
in most cases the best results can be obtained when they are
used to modify the master curve.

Black-point slider White-point slider
The Curves and Levels Drawer:  Black and White Points
The black-point slider

Click the black-point slider once to activate it, then drag it to
the right or left to set the new black point.  All pixels in the
input with a value less than the black point will be mapped to
an output value of zero.  This can be used to eliminate points
from the curve that are not represented in the input, enhanc-
ing contrast, or to adjust brightness.  If a histogram is dis-
played in the gamma curve window, the black point can be set
to the lowest available input value by matching the slider with
the left-most bar in the histogram.  The effects of the new black
point can be ascertained by observing the preview image, which
is adjusted automatically to match changes in the black point.
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The white point slider

Click the white-point slider once to activate it, then drag it to
the right or left to set the new white point.  All pixels in the
input with a value greater than the white point will be mapped
to the maximum possible output value.  This can be used to
eliminate points from the curve that are not represented in the
input, enhancing contrast, or to adjust brightness.  If a histogram
is displayed in the gamma curve window, the white point can be
set to the highest available input value by matching the slider
with the right-most bar in the histogram.  The effects of the
new white point can be ascertained by observing the preview
image, which is adjusted automatically to match changes in the
white point.
The Curves and Levels Drawer:  Black and White Points
Undoing changes

To restore the black and white points to their default values,
click the reset button.   If the option key on the keyboard is
held down when the reset button is clicked, the gamma curves
for all channels will be reset.
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Setting the black and white points by sampling

The black and white points can be set by directly sampling the
pixels in the preview area.  This provides a means of matching
the black and white points to the minimum and maximum
values actually visible in the original film.  Direct sampling can be
used to set the end points of the gamma curve for any channel,
but is most effective when used with the master channel.

Sampling the black point

To set the black point, or minimum input value, select the
desired color channel and then click the black-point button
( ).  When the button is clicked, the cursor will become an
eye-dropper when moved over the image in the preview/crop
area.

Move the cursor to the point to be used as the darkest in the
image.  You may wish to close the curves and levels drawer so
that you can view the pixel data display to determine which
area of the image is the darkest for the color or colors in the
current color channel.  The darkest point in the image will have
the lowest pixel values for that color.  With the cursor over the
point that is to serve as the darkest in the image, click the
mouse button.  The selected point will be the new black point,
or reference point for darkness.  The cursor will return to its
previous shape, and the preview image will automatically be
altered to reflect the new black point.
The Curves and Levels Drawer:  Black and White Points
Note:  Sampling the black point does not change the master
curve.  If the master channel is selected when the black point is
sampled, the black point for each individual color channel (e.g., the
channels for red, green, and blue in the case of RGB) will be
altered to match the input value for that color at the pixel sampled,
but the black point for the master channel will remain unaltered.
The new black points for the remaining color channels can be
viewed by holding down the histogram button (  ).

Note:  The black-point button is only active when a preview
image is displayed in the preview/crop area.
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Sampling the white point

To set the white point, or maximum input value, select the
desired color channel and then click the white-point button
( ).  When the button is clicked, the cursor will become an
eye-dropper when moved over the image in the preview/crop
area.

Move the cursor to the point to be used as the brightest in the
image.  You may wish to close the curves and levels drawer so
that you can view the pixel data display to determine which
area of the image is the brightest for the current color channel.
The brightest point in the image will have the highest pixel
values for the color or colors in the current channel.  With the
cursor over the point that is to serve as the brightest point in
the image, click the mouse button.  The selected point will be
the new white point, or reference point for brightness.  The
cursor will return to its previous shape, and the preview image
will automatically be altered to reflect the new white point.

Note:  Sampling the white point does not change the master
curve.  If the master channel is selected when the white point is
sampled, the white point for each individual color channel (e.g., the
channels for red, green, and blue in the case of RGB) will be
altered to match the input value for that color at the pixel sampled,
but the white point for the master channel will remain unaltered.
The new white points for the remaining color channels can be
viewed by holding down the histogram button (  ).
The Curves and Levels Drawer:  Black and White Points
Note:  The white-point button is only active when a preview
image is displayed in the preview/crop area.

Undoing changes

To restore the black and white points to their default values,
click the reset button.  If the option key on the keyboard is
held down when the reset button is clicked, the gamma curves
for all channels will be reset to linear.
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Displaying the Modified Histogram

Pressing the histogram button ( ) in the curves and levels
drawer displays a histogram for the output image, which reflects
any modifications to the gamma curve for the current channel.

The modified histogram will only be displayed while the histo-
gram button is held down.  When the button is released, the
original input histogram will be restored.
The Curves and Levels Drawer:  Displaying the Histogram
Importing Settings

Level settings created and saved using Adobe Photoshop can
be read into Nikon Scan and used to modify how images will be
scanned.  To import settings, click the import button in the
curves and levels drawer.

The standard open dialog will be displayed, allowing you to
navigate to the folder where the Photoshop settings are stored.

Note:  When settings are imported into Nikon Scan, the end-
points of the gamma curves will be set to the values in the im-
ported settings and the gamma value will center around 1.00.  Any
points added to the gamma curves in the curves and levels window
will be lost.

Import button
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HSL Controls

When the selected color space is HSL, gamma curves will not
be displayed in the curves and levels drawer.  Instead, HSL
controls appear, making it possible to determine how input hue,
saturation, and luminance will be altered when the image is
scanned.

The HSL controls consist of a saturation slider and separate
channels for luminance and hue.  The following channel pop-up
menu will appear when the channel menu button is clicked.
The appearance of the drawer will vary depending on whether
luminance or hue is selected.

Saturation
slider

Channel
menu button
The Curves and Levels Drawer:  HSL Controls
Using the saturation slider

The saturation slider appears in the displays for both the lumi-
nance and hue channels.  Its function is equivalent to that of the
gamma slider in the RGB, CMYK, and grayscale gamma win-
dows.  Raising the slider increases saturation and decreases the
gamma value, creating a preview image with deeper colors,
while lowering the slider increases the gamma value, lightening
the colors in the image.  The center of the scale is equivalent to
a gamma value of 1.00
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Editing the hue channel

When the hue channel is selected from the channel pop-up
menu, the curves-and-levels drawer takes on the appearance
shown below.  The controls for editing hue are unique, consist-
ing of a horizontal line crossing a rainbow-colored background.
The input values for each hue (color) are plotted along a straight
line running through the center of the editing window.  Points
on the control line can be raised or lowered to map the input
color to a new output color.

Input color
(color in original

image)

Output color
(color after

scanning)

Width slider

Point-edit cursor
The Curves and Levels Drawer:  HSL Controls
The width slider

When a point on the control curve is moved, the control curve
will be altered to pass through the new point using a simple
bell-shaped curve to join the new point to the center line.  The
width of the bell curve can be adjusted using the width slider.
These hue controls provide an extremely powerful editing
function which allows the user to change the mapping for a
specific color without affecting other colors in the image.  To
determine the color of a specific pixel, move the cursor over
the preview image in the scan window.  A point on the input
line corresponding to the color of the pixel under the cursor
will be highlighted in the curves and levels edit window.

The scale button

The vertical scale can be changed by clicking the scale button
beneath the edit window.  Increasing the scale gives the user
more colors to choose from for each input point.

Scale button
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The input slider

The slider on the right of the window can be used to change all
input colors at once.

The reset button

To restore the hue controls to their default values, click the
reset button.  If the option key on the keyboard is held down
when the reset button is clicked, both the hue and the lumi-
nance channels will be reset.

Input slider

Reset button
The Curves and Levels Drawer:  HSL Controls
The luminance channel

Using the luminance channel, it is possible to control how input
luminance (brightness) will be changed when the image is
scanned.  The luminance controls are similar to the gamma,
black-point, and white-point slider controls discussed in the
preceding sections, consisting of a luminance slider, which
controls the main luminance curve, and sliders to set the mini-
mum and maximum values for input luminance.  The luminance
curve-editing window also contains a histogram.  The horizontal
axis of the histogram gives the value for luminance, with mini-
mum luminance on the left and maximum luminance on the
right.  The bars in the histogram show the number of pixels in
the current crop at each point on the luminance scale.

Minimum input-
luminance slider

Maximum input-
luminance slider

Luminance-
curve slider
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Moving the luminance-curve slider to the left increases output
luminance, making the image brighter, while moving the slider to
the right decreases output luminance, creating a darker image.
The effects of the luminance slider can be determined by view-
ing the image in the preview/crop area.

The sliders for maximum and minimum luminance can be used
to adjust output luminance to match the range of values actually
present in the input, so making best use of the scanner’s dy-
namic range.  The minimum input-luminance slider sets the
minimum value for input luminance.  All pixels in the input
image that have values less than the minimum are converted to
a value of zero (black) when scanned.  The minimum value
increases when the slider is moved to the right and decreases
when the slider is moved to the left.  The minimum input-
luminance value can be matched with the lowest value actually
present in the input image by matching the slider with the left-
most bar in the histogram.  The luminance value for a specific
pixel in the input image can also be determined by moving the
cursor over the preview image in the scan window.  A point on
the horizontal axis equivalent to the luminance value of the
pixel under the cursor will be highlighted in curves and levels
edit window.

The maximum input-luminance slider is used to set the maxi-
mum value for input luminance.  All pixels in the input image
that have values greater than the maximum are converted to
white (i.e., the maximum output value, which varies depend-
ing on scanner bit-depth) when scanned.  The maximum value
The Curves and Levels Drawer:  HSL Controls
decreases when the slider is moved to the left and increases
when the slider is moved to the right.  The maximum input-
luminance value can be matched with the highest value actually
present in the input image by matching the slider with the right-
most bar in the histogram.

To restore the hue controls to their default values, click the
reset button.  If the option key on the keyboard is held down
when the reset button is clicked, both the hue and the lumi-
nance channels will be reset.
- 87 -



The Color Balance Drawer
Nikon Scan 2.0 offers two means of adjusting the colors in an
image.  One is the curves and levels drawer, discussed in the
previous chapter, which offers selective control over the output
levels for the components of each color space.  The other is the
color balance drawer, which provides a straight-forward means
of adjusting overall color balance, brightness, and contrast for
the entire image.  This chapter explains the operations that can
be performed using the color balance drawer.

Opening the Color Balance Drawer

Clicking the color-balance drawer-tab in the control area of the
scan window opens the color-balance drawer.  The drawer can
be closed by clicking the button at its right edge.
The Color Balance Drawer:  Opening the Color Balance Drawe
     

Note:  The color balance drawer is active only when the current
color space is sRGB/RGB or grayscale.

Color balance
drawer tab

Color balance
drawer

Drawer close
button
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Color Balance Controls

When the color space is sRGB or RGB, the color balance tab
will contain the controls shown below.  When the color space
is grayscale, only the brightness and contrast sliders will be
active.

Brightness, contrast, and color balance can be set by dragging
the sliders to the right or left.  Any changes made in the color
balance drawer will be reflected immediately in the preview
image in the scan window.

Brightness

The brightness slider adjusts brightness for the entire image.
Dragging the brightness slider to the right brightens all the
colors in the image, making the image as a whole more white.
Dragging the slider to the left darkens all the colors in the
image, making the image as a whole darker and less distinct.
The Color Balance Drawer:  Color Balance Controls
Contrast

Dragging the contrast slider to the right heightens the difference
between highlights and shadows in the image, increasing con-
trast.  Dragging the slider to the left decreases the difference
between light and dark portions of the image, making the
images flat and dull.

Color balance

While the brightness slider adjusts brightness for the image as a
whole, the three color balance controls allow the user to adjust
brightness for each color individually.  For example, dragging the
red slider to the right brightens the red portions of the image,
making the image as a whole more red.  Dragging it to the left
dims the red elements in the image, bringing out the remaining
colors.

Note:  The brightness and color sliders have the same function as
the gamma slider (brightness corresponds to the slider for the
master curve, the color sliders to the curves for each color ele-
ment).  When contrast is increased with the contrast slider, the
effect is the same as if the white- and black- points were moved
toward one another, steepening the master gamma curve.  The
two drawers however function however independently of one
another; hence changes in one drawer are not reflected in the
other.  If separate adjustments are made in each drawer, the
changes will be merged when the image is scanned.
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Saving and Loading Settings
This chapter describes how to save changes to scan settings
made in the scan window and how to restore previously saved
settings.

The Settings Menu

The control area of the scan window contains a settings pop-up
menu, which is used to save the current scan settings and to
restore settings previously saved.  To open the settings pop-up
menu, click the settings menu button.

Settings menu
button
Saving and Loading Settings:  The Settings Menu
The settings saved using the settings menu are all those that can
be adjusted in the scan window, including:

• the currently selected device, media and film type, output
units, the dimensions and location of the current crop, and
any flips or rotates currently in effect

• input and output lock, output resolution value, and scale

• the master gamma curve for the current color space and the
gamma curves for each channel, brightness and contrast
settings, and color balance

• scanner settings and information on whether interactive help
is on or off

Note:  The settings for different scanners are not mutually com-
patible.  For example, settings saved when a LS-20 film scanner
was the selected device cannot be read or used while another
device, such as the LS-2000, is the currently selected scanner.
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Adding settings to the settings menu

When the Save Settings… option is chosen from the settings
pop-up menu, the Save Settings dialog appears.

Enter a name for the current settings in the text box and click
the OK button.  Settings are saved in a special file in the same
folder as Nikon Scan 2.0.  Click the Cancel button to exit the
Save Settings dialog without saving the current settings.

If settings have previously been saved under the same name, a
warning will appear when the OK button is clicked.  Click Yes
to overwrite the previously saved settings, or No to return to
the Save Settings dialog and enter a new name.
Saving and Loading Settings:  The Settings Menu
Loading settings from the settings menu

Saved settings will be added to the end of the settings pop-up
menu.  To restore previously saved settings, select the desired
settings from the menu.  The settings in the scan window will
immediately be altered to match the saved values.
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Deleting settings from the settings menu

When Delete Settings… is chosen from the settings pop-up
menu, the Delete Settings window appears and the settings to
be deleted can be chosen from a pop-up menu.

Choose the settings to be deleted from the pop-up menu and
click the Delete button.  To exit the window without deleting
the chosen settings, click Cancel.

Once settings have been deleted, their names will no longer be
displayed at the end of the settings menu.
Saving and Loading Settings:  The Settings Menu
Restoring factory defaults

If Reset to Factory Defaults is chosen from the settings
menu, scan-window settings will be returned to factory default
values.
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Exporting and Importing Settings

You can save the current scan window settings to a file using
Export Settings….  Unlike Save Settings…, which saves
settings in a system file that can only be accessed by Nikon Scan
2.0, Export Settings… saves settings to independent files.
These files can be read using Import Settings….  It is recom-
mended that Export Settings… be used to store settings in a
location separate from Nikon Scan, for example in the same
folder as the images scanned at the saved settings.

Exporting settings

When Export Settings… is chosen from the settings menu,
the standard save file dialog will appear.  After specifying the
drive and folder to which the settings are to be saved and
entering a file name for the settings, click the Save button to
save the settings under the specified name.
Saving and Loading Settings:  Exporting and Importing Settings
Importing settings

Settings saved with Export Settings… can be read using the
Import Settings… command.

When Import Settings… is chosen from the settings menu,
the standard open file dialog will appear.  Choose the drive and
folder containing the settings to be read and select the desired
file, then click the Open button to load the specified settings
into Nikon Scan.

When a settings file is read into Nikon Scan, the preview image
in the scan window will disappear.
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Image Window Operations
When Nikon Scan 2.0 is used as a stand-alone application,
images will be opened in the Nikon Scan applet after scanning.
The Nikon Scan applet is a small-scale application that allows
the user to flip and rotate images after scanning, save images to
disk in a variety of file formats, open previously saved image
files, and print images.  This chapter describes the Nikon Scan
applet and its functions.

Note:  When Nikon Scan 2.0 is being used as an acquire plug-in
for another application such as Adobe Photoshop rather than as a
stand-alone application, images will be opened in the host applica-
tion.  Refer to the application’s manual for details on post-scan
image editing.
Image Window Operations
The Nikon Scan Applet

When Nikon Scan 2.0 is used as a stand-alone application,
scanned images will be opened in image windows on the desk-
top, where they can be viewed, modified, printed, or saved.
The operations that can be performed in image windows are
carried out using the menus in the Nikon Scan menu bar.

▼ The Nikon Scan menu bar

▼ Image window
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The menu bar

Nikon Scan’s menus are shown below.  Each menu item in the
illustrations below is linked to the section of this manual in
which its function is explained.  Click on the menu items in the
illustration to view a description of their function.
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window to its original dimensions.
Moving and resizing image windows

Image windows can be moved and resized using standard
window controls.  Drag the lower right corner of the window
to adjust to any size between 600 × 450 pixels and the dimen-
sions of the computer monitor.  Drag the title bar to move the
window anywhere on the desktop.

Title bar
Image Window Operations:  The Nikon Scan Applet
Window control buttons

The window control buttons in the title bar offer the following
functions (the title bar shown below is for MacOS 8.0 or later;
System 7 does not offer a “window-shade” button):

 (Close)
Closes the image window.  The active image
window can also be closed by selecting
Close from the File menu.

 (Resize)
Enlarges the window to fill the screen.  Click
the button a second time to return the
window to its original dimensions.

 (Window-shade)
Reduces the window to a floating title bar.
Click the button a second time to return the
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Zoom

The image in the active image window can be zoomed in or out
using the commands in the View menu.  The image in the active
image window can also be zoomed in by selecting Zoom In
from the View menu, or by clicking the zoom-in button at the
bottom of the window.  To zoom the image out, select Zoom
Out from the View menu or click the zoom-out button.

          

         

Zoom in

Zoom out

Zoom-in button

Zoom-out button
Image Window Operations:  Zoom
To view the image at a zoom ratio of one to one, select Ac-
tual Size from the Window menu..

To view the image at the maximum zoom ratio at which the
entire image can be seen on the desktop, select Fit to Screen
from the Window menu.  The image window will be resized
to the maximum possible dimensions that allow the entire
image to be displayed on the desktop, and the image scaled to
fill the image window.
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Rotating and Flipping Images

The image in the active image window can be flipped or rotated
using the commands in the Transform submenu of the View
menu.

Rotate CW: Rotates the image clockwise, ninety
degrees at a time.

Rotate CCW: Rotates the image counter-clockwise,
ninety degrees at a time.

Flip Horizontal: Flips the image horizontally.

Flip Vertical: Flips the image vertically.

Flip Both Axes: Flips the image both horizontally and
vertically.
Image Window Operations:  Rotating and Flipping Images
Rotating images

The image in the active image window can be rotated using the
Rotate CW and Rotate CCW commands in the Transform
submenu.  For example, the image will be rotated ninety degrees
to the right each time Rotate CW is selected.
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Flipping images

The image in the active image window can be flipped using the
Flip Horizontal, Flip Vertical, and Flip both Axes com-
mands in the Transform submenu.  For example, the image
will be flipped horizontally time Flip Horizontal is selected.
Image Window Operations:  Rotating and Flipping Images
Copying Images to the Clipboard

The image in the active image window can be copied to the
clipboard by choosing Copy from the Edit menu.  The images
that have been copied to the clipboard can be pasted to other
applications.

Note: The “cut,” “paste,” “clear,” and “select all” commands are
placed in the Edit menu to allow users access to the standard
keyboard shortcuts (command+X, command+V, delete, and
command+A) when a dialog containing a text box is open.  These
commands are always grayed out and unavailable when an image
window is active.
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Saving Images to Disk

The image in the active image window can be saved by choos-
ing Save As… from the File menu.

The Save As dialog will appear.  Navigate to the drive and
folder to which the image is to be saved, enter a name for the
file in the Save this document as text box, and choose a file
type and image quality for the file.
Image Window Operations:  Saving Images to Disk
File type and image quality can be selected from the following
pop-up menus.  The image quality menu, which controls how
much JPEG images are compressed when saved, is only available
when the selected file type is JPEG, JPEG PICT, or JPEG FlashPix.
JPEG compression results in loss of detail in the saved image;
the more the image is compressed, the greater the loss of detail
will be.

       

The image will be saved in the specified location when the
Save button is clicked.  Clicking Cancel closes the Save As
dialog without saving the image.  Once an image has been
saved to disk, it can be saved again under the same name and in
the same location by choosing Save from the File menu.
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Reading Images from Disk

Images that have been saved using the Save As command can
be opened in Nikon Scan by choosing Open… from the File
menu.

The Open dialog will appear.  Navigate to the drive and folder
containing the image file and double-click the file name or select
the file and click the Open button.  The selected file will be
opened in an image window.
Image Window Operations:  Reading Images from Disk
You can switch among multiple image windows by selecting the
desired image from those listed at the bottom of the Window
menu.
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Printing Images

The image in the active image window can be printed using the
two printing commands in the File menu.

Page Setup

To choose a printer and make changes to page size and other
printing options, choose Page Setup… from the File menu.
The Page Setup dialog will appear.

The Page Setup dialog differs depending on what printer is
selected.
Image Window Operations:  Printing Images
Print

To print the image, select Print from the File menu.

The Print dialog will appear.

In the Print dialog, chose a printer, printing resolution, and the
number of copies to be printed, then click the Print button to
print the image.  Clicking Cancel closes the Print dialog with-
out printing the image.
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Scan Window Settings

Scan window settings for a selected scanner can be changed
from the Nikon Scan menu.

Nikon Scan menu options

Device: Open the scan window for a selected scanner
by choosing the device from those listed in
this submenu.

Settings: This submenu is only available when a scan
window is active.  When a scan window is
active, this submenu offers the same com-
mands as the settings pop-up menu in the
scan window.  Using this menu, you can save
and load settings or restore factory defaults
for the active scan window.
Image Window Operations:  Scan Window Settings
Color Space:
When a scan window is active, this submenu
offers the same commands as the color-space
pop-up menu in the scan window.  Using this
menu, you can change the color space in the
active scan window.  When an image window
is active, you can select a new color space for
the image from among RGB, sRGB, CMYK,
and HSL.  Note that as HSL is not supported
by any of the available file formats, you must
change the document color space to RGB or
CMYK before saving an HSL image.

Film Type: This submenu is only available when a scan
window is active.  When a scan window is
active, this submenu offers the same com-
mands as the film-type pop-up menu in the
scan window.  Using this menu, you can change
the film type in the active scan window.

Eject/Next Slide:
This command is only available when a scan
window is active, when it performs the same
function as the eject button in the scan win-
dow control area.
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Slide Feeder:
If the device selected in the active scan win-
dow has a slide feeder, a batch-scan dialog
appears.  Enter the number of slides to be
scanned in the number of slides to scan
text-box and click OK.  The number chosen
will be entered in the Slide Feeder Scan panel
of the scanner extras drawer (see “LS-2000
Scanner Extras” in Appendix A, below).
Image Window Operations:  Scan Window Settings
Quitting Nikon Scan

To quit Nikon Scan, choose Quit from the File menu.

If there are images in the main window that have yet to be
saved to disk, you will be prompted to save them before exit-
ing.
- 104 -



Appendix A:  Scanner Extras
The contents of the scan window’s “scanner extras” drawer
vary depending on the currently selected device.  The scanner
extras drawers for each of the scanners supported by Nikon
Scan are given in the sections that follow.

Opening the Scanner Extras Drawer

To open the scanner extras drawer for the currently selected
device, click the scanner extras drawer tab in the control area of
the scan window.  The drawer can be closed by clicking the tab
at its right edge.

     
Scanner Extras:  Opening the Scanner Extras Drawer
LS-2000 Scanner Extras

The scanner extras drawer for the LS-2000 consists of two
sections.  The top section contains a pop-up menu listing the
features available for adapter currently inserted in the scanner.
The bottom section contains pop-up menus or sliders that
allow the user to choose settings for the selected feature.

To change the scanner extras settings, select the desired feature
from the features pop-up menu, then select the settings for that
feature from the settings pop-up menu or menus.  The features
pop-up menu is shown below.

Features pop-up
menu button
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The LS-2000 scanner extras drawer allows access to the follow-
ing items:

• pixel data size
• defect correction
• manual focus adjustment
• analog gain
• multi sample scanning
• miscellaneous settings

• software interpolation
• negative prescan mode

• module extras
• strip film offset (SA-20 strip film adapter)
• IX240 crop choices (IA-20 IX240 film adapter)
• slide-feeder scan (SF-200 slide-feeder adapter)

Note:  Changes to settings in the scanner extras drawer do not
take effect until the preview or scan button is clicked.  Settings are
canceled if a thumbnail is selected before a preview scan is per-
formed.  After changing scanner extras settings, perform a preview
scan before selecting thumbnails.
Scanner Extras:  LS-2000 Scanner Extras
Pixel data size

The pixel data-size dialog controls the bit depth of the scanned
image.  Images can be scanned at a depth of eight bits per pixel,
which produces images containing a maximum of 256 colors or
shades of gray, or at a depth of twelve bits per pixel, producing
a maximum of 4,096 colors or shades of gray.

Increasing pixel data size from eight to twelve increases the file
size by half a byte for every pixel in the image.

Note:  Images scanned at a bit depth of twelve bits are converted
to sixteen bits when opened in the host application, or to eight bits
when the color space is CMYK.  If the color space is HSL, images
will be processed at a bit depth of sixteen bits per pixel regardless
of the bit-depth setting.  If the bit-depth is set to eight bits per
pixel, HSL images will be converted to eight bits when passed to
the host application.
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Defect Correction

”Defect Correction” digitally removes dust and scratches from
scanned images.  “Defect Correction” settings can be chosen
from the pop-up menu shown below at right.

Off: No compensation is made for scratches or
dust.  The image is scanned “as is.”

On (Normal):
The image is digitally processed to remove
scratches and dust.  The effects of “Defect
Correction” are reflected in the preview image.

On (Sharpen):
Defect correction may sometimes blur details
of the image.  Select this option to sharpen
edges while correcting defects.

Click the Help button for information on using Defect Correc-
tion settings.
Scanner Extras:  LS-2000 Scanner Extras
Manual focus adjustment

Manual focus adjustment allows you to adjust focus using the
focus position slider.  Changes to focus take effect when the
image is previewed or scanned.  Click the Help button for
information on using manual focus adjustment.
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Analog gain

Analog gain is used to adjust the intensity of the scanner‘s light
source, emphasizing selected colors in the input image.  The
controls for analog gain consist of four sliders:  a master slider
that allows the user to increase the brightness of all LEDs in the
scanner’s light source simultaneously, and red, green, and blue
sliders that allow independent adjustment of the red, green, and
blue LEDs.

Moving a slider to the right increases the intensity of the af-
fected LED; moving it to the left decreases the intensity.  Click
the Help button for information on using analog gain.

Note:  Setting the intensity of the scanner’s light source too high
may produce “smear” or other defects in the scanned image.
Scanner Extras:  LS-2000 Scanner Extras
Multi-sample scanning

“Multi-sample scanning” controls the pixel bit-depth of the
scanner’s analog-to-digital conversion.  The actual bit-depth is
twelve bits per pixel; the bit-depth can however be increased
using multi-sample scanning to reduce system noise, ensuring a
true twelve-bit image.  In practice, a twelve-bit image produced
by multi-sample scanning can be of a quality equal to a sixteen-
bit image produced without noise reduction.
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The following multi-sample scanning options are available:

Normal (1x):
Multi-sample scanning is not performed
(normal image quality)

Fine (4x): Multi-sample scanning is performed, increasing
pixel depth by two bits per pixel (“fine”
image quality)

Super Fine (16x):
Multi-sample scanning is performed, increasing
pixel depth by four bits per pixel (“super fine”
image quality)

Click the Help button for information on multi-sample scan-
ning.
Scanner Extras:  LS-2000 Scanner Extras
Miscellaneous settings

“Miscellaneous” offers the following two controls:  software
interpolation and negative prescan mode.  The first item deter-
mines how the image will be digitally processed when scanned,
the second controls the autoexposure settings for negative film.

Click the Help button for information on miscellaneous set-
tings.
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Software interpolation

The LS-2000 supports resolutions of 2,700dpi and all fractions
of 2,700dpi with a whole-number denominator (e.g.,
2,700/2=1,350dpi, 2,700/3=900dpi, etc.).   At other resolutions,
some pixels must be generated by computer algorithm to make
up the specified number of pixels per inch.  Software interpola-
tion controls the algorithm used in generating these extra pixels.
The following choices are available:

Bilinear: Extra pixels are generated using a bilinear
algorithm

Neighbor: Extra pixels are generated using a “nearest
neighbor” algorithm

None: No interpolation is performed (in this case,
the scanned image will be larger than the
value indicated in the scan-size drawer)

Negative prescan mode

For the best possible results, a prescan is required when nega-
tive film is used.  The prescan method can be chosen from
“normal” and “alternative.”  “Alternative” is used when scanning
images with no clear black- and white-point, such as close-up
photographs in which a narrow range of colors predominates.
Scanner Extras:  LS-2000 Scanner Extras
Module extras

Separate module extras are available for the SA-20 strip-film
adapter, the IA-20 IX240 film adapter (an optional accessory
available separately for the LS-2000), and the SF-200 slide-
feeder adapter (available separately).

Strip-film offset (SA-20 strip-film adapter extras)

Strip-film offset is available when the SA-20 strip-film adapter is
inserted in the LS-2000’s adapter slot.  This option can be used
to adjust the offset when the position of the film differs slightly
from the scan position.  To use this option, the thumbnail
drawer must be open with thumbnails displayed.  The position
of the film can then be adjusted using the slider.  The effects of
offset can be judged by clicking the Reload button.
- 110 -



IX240 crop choices (IA-20 IX240 film adapter extras)

IX240 crop choices are available when the IA-20 adapter for
IX240 film (sold separately) is inserted in the LS-2000 and
control the crop setting for different IX240 film apertures.

Classic: The initial crop in the preview/crop area is
adjusted to suit photographs made at an
aperture setting of “classic.”

Wide: The initial crop in the preview/crop area is
adjusted to suit photographs made at an
aperture setting of “wide.”

Panorama: The initial crop in the preview/crop area is
adjusted to suit photographs made at an
aperture setting of “panorama.”
Scanner Extras:  LS-2000 Scanner Extras
Slide-feeder scan (SF-200 slide-feeder module extras)

Slide-feeder scan settings are available when the SF-200 slide-
feeder adapter (sold separately) is inserted in the LS-2000.  The
number of slides to be scanned when the scan button is
clicked can be set by entering a number in the Feed Images
text box.  Pressing the scan button will cause the specified
number of slides to be scanned at current scan settings and
passed to the calling application.  To scan all slides in the feeder,
enter a large number such as “999”.
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Appendix B: Installation Map
This section lists the files on the installer CD and the locations
of the files installed by the Nikon Scan 2.0.

Nikon Scan 2.0 Installer CD-ROM

The Nikon Scan 2.0 installer CD-ROM contains the following
files:

Folder/File Name Notes

ReadMe “Read Me” file for the Nikon Scan 2.0
installer CD-ROM

License Agreement Software license agreement

Nikon Scan 2.0 Installer EN Installer (English version)
Depending on your region, installers for the
German (Installer DE), French (FR), and
Spanish (ES) versions of Nikon Scan 2.0
may also be included.

Nikon Scan 2.0 EN Folder containing the files used by the
Nikon Scan 2.0 Installer EN
Other folders containing the files used by
the installers for other language versions
may also be included.

Other folders Depending on your region, the installer disk
may also include additional folders contain-
ing the installers for software bundled with
Nikon Scan 2.0.  Read the “ReadMe” files in
these folders for more information.
Installation Map
Nikon Scan 2.0 Installation Map

The Nikon Scan 2.0 installer installs the following files to the
locations listed below.

Folder/File Name

Nikon Software

Notes

Folder for Nikon
software1,2,3

Destination directory

User-specified directory
(defaults to the start-up
disk)

Nikon Scan 2.0 folderNikon Scan 2.0

ReadMe “Read Me” file for
Nikon Scan 2.01,2,3

″

Folder for Nikon
Scan 2.01,2,3

License Agreement

″

File containing text of
license agreement1,2,3

Nikon Scan 2.0 Nikon Scan 2.0
applet1

System folder | Prefer-
ences folder

Nikon Scan 2.0 plug-
in2

Nikon Scan Plugin 2.0 Nikon Scan 2.0 folder
and/or user-specified
application plugins folder

Folder for scanner
drivers (modules)1,2

Nikon MAID folder

Nikon MAID

LS2000 Module Driver for LS-2000
film scanner1,2

MAID Driver ″Driver1,2

″

″Profiles Folder for color
management pro-
files1,2

SDCLPower Defect Correction
module1,2

″
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Folder/File Name Notes Destination directory

NKLS2000Posi_16.icm Scanner profile for
LS-20001,2

Profiles folder

Notes

1 Installed by “Easy Install” and “Custom Install/Nikon Scan” options

2 Installed by “Easy Install” and “Custom Install/Nikon Scan Plugin 2.0”
options

3 Installed by “Easy Install” and “Custom Install/Profiles” options

NKLS2000Posi_8.icm ″1,2 ″
NKLS2000Posi_SD_16.icm ″1,2 ″

NKLS2000Nega_16.icm ″1,2 ″
NKLS2000Posi_SD_8.icm ″1,2 ″

NKLS2000Nega_8.icm ″1,2 ″
NKLS2000Nega_SD_16.icm ″1,2 ″
NKLS2000Nega_SD_8.icm ″1,2 ″
NKMonitor_Mac.icm Monitor profiles1,2 ″
NKsRGB.icm Profile for calibrated

RGB color space1,2

″

NKLch.icm Profile for Lch (HSL)
color space1,2

″

NKCMYK_SWOP.icm CMYK color library1,2 ″
LS2000_Mac.icm ColorSync profiles3 System folder | Prefer-

ences | ColorSync

Utility Utility folder1,2 Nikon Scan 2.0 folder

Attachment Utility Attachment utility for
optional SF-200 slide
feeder for LS-20001,2

Utility folder
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Appendix C:  Uninstall
Nikon Scan can be removed from your system using the “Re-
move” option in the Nikon Scan installer dialog.  Insert the
Nikon Scan 2.0 CD into your computer’s CD-ROM drive and
double-click the installer for the language of your choice.

Complete steps 1–3 of the installation process as described in
“Before You Begin:  Software Installation.”  The installer dialog will
be displayed.
Uninstall
Click the menu button at the top right corner of the installer
dialog and select Remove from the menu that appears.

The contents of the installer dialog will change to those shown
above.  Click Remove to remove Nikon Scan and all related
files from your system.
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